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1 Overview 

1.1 System and Software Requirements 

TCI Installation on the following minimum operation systems and software prerequisites: 

▪ Windows Server 2016 

▪ Java runtime environment 17 for Windows x64 

▪ Apache Tomcat 9.0.x 

For the file cache, at least 500GB of disk space are recommended. 

Each 3DEXPERIENCE batch server must have a graphics card, please consult the Dassault 

Systèmes recommendations: 

http://media.3ds.com/support/certified_hardware/Windows_10_64-bit.html 

https://media.3ds.com/support/certified_hardware/Windows_11_64-bit.html 

 

The following systems are supported: 

▪ 3DEXPERIENCE R2021x 

▪ 3DEXPERIENCE R2022x 

▪ 3DEXPERIENCE R2023x 

▪ 3DEXPERIENCE R2024x 

▪ 3DEXPERIENCE Public Cloud 

▪ Teamcenter 12 (4-tier) 

▪ Teamcenter 13 (4-tier) 

▪ Teamcenter 14 (4-tier) 

▪ Teamcenter 2312 (4-tier) 

▪ Teamcenter Active Workspace 6.2 

▪ Teamcenter Active Workspace 6.3 

▪ Teamcenter Active Workspace 2312 

The following DBMS are supported: 

▪ Oracle Database 11g Release 2 and above 

▪ H2 DB 1.4 

▪ MS SQL Server 2012 and above 

http://media.3ds.com/support/certified_hardware/Windows_10_64-bit.html
https://media.3ds.com/support/certified_hardware/Windows_11_64-bit.html
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1.1.1 3DEXPERIENCE licenses and user rights 

1.1.1.1 On Premise: licenses 

Product Trigram 

Collaborative Business & Industry Innovation, 

includes:  

CSV (Platform Contributor)  

IFW (Platform Member)  

PCS 

Engineering Adapter for X-PDM  MUX (not required for XPDM import with 

POWER'BY)  

Engineering Data Exchange Manager EXH (not required for XPDM import with 

POWER'BY) 

Optional 

Product Manager PDM (for Configuration / Variant 

Management)(required for authoring only) 

Collaborative Designer for CATIA V5 UE5 (for CATIA V5 POWER'BY import) 

Conversion Data Integrator FO* (for XCAD conversion of specific 

format, e.g. FOJ for JT support) 

Table 1: Required 3DEXPERIENCE licenses in On Premise environment. 

Note: Additional licenses depend on respective use cases. 

1.1.1.2 On Premise: User rights 

The 3DEXPERIENCE user executing the import and export operations needs to have Leader role 

assigned in the Collaborative Spaces to / from which data is transferred. 

The user needs business and system administrator privileges as required by Dassault Systèmes. 

These rights can only be assigned using MQL: 

modify person username access all admin all type system type business; 
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1.1.1.3 On Public Cloud: licenses 

Product Trigram 

Collaborative Business & Industry Innovator 

Package: 

IFW-OC (Collaborative Business Innovator) 

CSV-OC (Collaborative Industry Innovator)  

PCS-OC 

Enterprise IP Exchange Manager XXH-OC 

Enterprise IP Exchange Package XXK-OC 

Engineering Data Exchange Manager EXH-OC 

Table 2: Required 3DEXPERIENCE licenses in Public Cloud environment 

Note: Additional licenses depend on respective use cases. 

1.1.1.4 CATIA V5 CAD Pre- and Postprocessing 

Batch processing of native CAD file data may be required for 3DEXPERIENCE Import 

(preprocessing) and 3DEXPERIENE Export (postprocessing). A CATIA V5 license for the respective 

CAD system e.g. for example HD2, M3D, PX1 (optional), EHI (optional for electric data support). 

1.1.2 Software Requirements for Oracle Database 

Copy the OJBDC driver matching your database version (e.g. ojdbc8.jar) from your Oracle 

installation or download it from Oracle website. Place the driver in the lib folder of the Tomcat that 

runs TCI. 

The recommended database character set is al32utf8. 

1.1.3 Software Requirements for MS SQL Server 

Download the JDBC driver for your database and Java runtime version from Microsoft (e.g. mssql-

jdbc-11.2.1.jre8.jar) and place the .jar file in the lib folder of the Tomcat that runs TCI. 

MS SQL Server must be configured with TCP connections enabled. 

1.2 Shipment 

The software delivery contains the following parts:  

▪ TCI 

▪ TCI Converter Server (XCI_CS) 

▪ TCI File Cache (XCI_FC) 

▪ TCI Teamcenter Rich Client Plugin (TCI_TC_UI) 

▪ TCI Teamcenter Active Workspace Client Plugin (TCI_AWC_UI) 

▪ TCI 3DEXPERIENCE Rich Client Extension (TCI_3DX_UI) 

▪ XCI 3DEXPERIENCE Batch (XCI_3DX_BATCH) 
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▪ COM/ReconV5 (COMReconV5) 

▪ Licman21 

▪ TCI documentation 

The product makes use of 3rd Party and Open Source Software. A list of the used products and its 

licenses is distributed with the software. 



 Infrastructure Overview 

TCI Release 3.11 - Installation Manual 5 

2 Infrastructure Overview 

2.1 Overview 

 

Figure 1: TCI Infrastructure Overview 
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2.2 Infrastructure Remarks 

The XCI 3DEXPERIENCE Batch must be installed at each TCI Converter Server that is used to run 

3DEXPERIENCE utilities. A 3DEXPERIENCE rich client environment (CATIA V6) is a prerequisite. 

If CATIA V5 Preprocessing or CATIA V5 Postprocessing is enabled, the COMReconV5 package 

must be installed at the configured hosts. A CATIA V5 client environment with the same CATIA V5 

version is a prerequisite. 
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3 Installing TCI 

3.1 Prerequisites 

3.1.1 Enable secure communication via https 

You can skip this step if no secure communication (http) is used. 

For secure communication (https) with the connected servers (Teamcenter and 3DEXPERIENCE) 

make sure that the necessary certificates are installed at the TCI host. The certificates must be 

copied from the Teamcenter server and the 3DEXPERIENCE server respectively and imported into 

the Java installation. 

Open a command shell as administrator and check or set the proper Java home directory: 

set JRE_HOME=<yourJavaDir> 

Use the keytool.exe in your Java installation. The default password is “changeit”. 

"%JRE_HOME%\bin\keytool.exe" -import -keystore 
"%JRE_HOME%\lib\security\cacerts" -storepass changeit -noprompt -trustcacerts -
alias <yourAlias> -file <yourFile.crt> 

3.1.2 Teamcenter 

The Teamcenter 4-tier server has been installed. 

The following values will be used in the following steps below: 

 

Setting Name Setting Value 

Teamcenter URL https://my.tc-server.url:8080/tc 

Table 3: Teamcenter settings 

3.1.2.1 Teamcenter SOA Client 

The Teamcenter SOA Client libraries of the file soa_client.zip of the Teamcenter installation 

package have to be extracted to a known directory, e.g. C:\TC2312\soa_client.  

This directory will be called <SOA_CLIENT> in this document. 

3.1.2.2 Teamcenter file handling 

Teamcenter can use FileServerCache or FileClientCache, see Teamcenter -> FileManagement 

settings. 

For FileClientCache the Teamcenter TCCS package must be installed to a known directory, e.g. 

C:\TC2312\tccs. This directory will be called <FMS_HOME> in this document. 
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3.1.3 3DEXPERIENCE 

3.1.3.1 Direct access to 3DEXPERIENCE server (On Premise) 

TCI requires access to the 3DEXPERIENCE server. As a prerequisite the following libraries must be 

copied from the 3DEXPERIENCE server installation: 

<3DEXPERIENCE install path> 

\3DSpace\win_b64\docs\javaserver\eMatrixServletRMI.jar 

<3DEXPERIENCE install path>\3DSpace\win_b64\docs\javaserver\FcsClient.jar 

to a directory on the TCI server host, for example C:\TCI\3dexp-lib. This directory will be called 

<3DEXP-LIB> in this document. 

3.2 TCI setup 

This section describes how you should install the TCI, XCI_FC, and XCI_CS web applications. 

3.2.1 Setup TCI as web application 

TCI will be deployed to a web application server. 

TCI will be installed in a directory on the host machine. This directory will be called 

<TCI_INSTALL_DIR> in the following steps. 

For example: 

 C:\TCI 

The web application server Tomcat must be installed to a known directory. We recommend installing 

Tomcat and other packages (e.g. XCI 3DEXPERIENCE Batch) in <TCI_INSTALL_DIR> to keep all 

components in one place.  

For example, for Tomcat this is then: 

C:\TCI\apache-tomcat-9.0.89. 

The Tomcat installation directory will be called <CATALINA_HOME> in this document. 

3.2.1.1 Package 

Locate the package XCI_TC_<TC Version>_3DX_<3DX Version>-<TCI Version>.zip (for 

example XCI_TC_2312_3DX_2024x-3.11.0.0.01.zip) and unzip to temporary location. 

In the next steps we will move and edit some of the delivered files. 

3.2.1.2 XCI_HOME directory 

Copy the XCI_HOME directory from the software package to <TCI_INSTALL_DIR> and remove the 

.sample from XCISettings.xml.sample.  

This directory will be the main working directory for TCI. The settings file controls behavior of TCI. 

3.2.1.3 Tomcat: Teamcenter and 3DEXPERIENCE libraries 

The web application must have access to the Teamcenter and 3DEXPERIENCE libraries in the 

classpath (see sections 3.1.2.1 and 3.1.3.1). Therefore, the following lines have to be added to the 

Tomcat configuration file <CATALINA_HOME>/conf/context.xml in the Resources section: 
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… 

<Resources> 

  <PostResources 

      className="org.apache.catalina.webresources.DirResourceSet" 

      base="<SOA_CLIENT>/java/libs" 

      webAppMount="/WEB-INF/lib"> 

  </PostResources> 

  <PostResources 

      className="org.apache.catalina.webresources.DirResourceSet" 

      base="<SOA_CLIENT>/java/libs/com.teamcenter.rac.external_2312" 

      webAppMount="/WEB-INF/lib"> 

  </PostResources> 

  <PostResources 

      className="org.apache.catalina.webresources.JarResourceSet" 

      base="<3DEXP-LIB>/eMatrixServletRMI.jar" 

      webAppMount="/WEB-INF/classes"> 

  </PostResources> 

  <PostResources 

      className="org.apache.catalina.webresources.JarResourceSet" 

      base="<3DEXP-LIB>/FcsClient.jar" 

      webAppMount="/WEB-INF/classes"> 

  </PostResources> 

</Resources> 

… 

 

Where <3DEXP-LIB> needs to be replaced by the absolute or relative path to the 3DEXPERIENCE 

library locations. <SOA_CLIENT> is the location of the extracted JAR files from the Teamcenter 

SOA Client libraries distributed with Teamcenter (see chapter 3.1.2.1). 

If TCI has been customized using the Java customization endpoints, please add additional entry 

pointing to the directory containing the customization .jar file. 

<PostResources 

      className="org.apache.catalina.webresources.DirResourceSet" 

      base="<XCI_HOME>/custom" 

      webAppMount="/WEB-INF/lib"> 

</PostResources> 

 

3.2.1.4 Tomcat: start script 

Copy the sample start script start-tomcat.bat.sample from the software package to 

<TCI_INSTALL_DIR> and remove the .sample file extension. This script is used to start Tomcat.   

Set the following environment variables in the start script. The FMS_HOME environment is needed only 

if TCI is configured to use FCC (see section 3.3.2.3.4). 
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Environment 

Variable 

Example Value Description 

XCI_HOME C:\TCI\XCI_HOME XCI home 

directory 

FMS_HOME C:\TC2312\tccs Teamcenter FMS 

home directory 

for using the FCC, 

not the FSC. 

CATALINA_HOME C:\TCI\apache-tomcat-9.0.89 Tomcat Catalina 

home directory 

JRE_HOME C:\Program Files\Java\jre-17.0.11+9 JRE home 

directory. 

JAVA_OPTS %JAVA_OPTS% 

-Djlicman.platform="Windows_2003_amd64" 

-Djava.library.path=%FMS_HOME%;%FMS_HOME%/lib 

-Xms256m -Xmx2048m 

Additional Java 

Options (-

Djava.library.path 

only needed if TCI 

is configured with 

FCC) 

Table 4: TCI web application environment variables 

3.2.1.5 Deploy TCI web application 

From the software package, copy the main application XCI.war, to the webapps directory of the 

web application server: <CATALINA_HOME>\webapps. 

3.2.2 Setup XCI_FC as web application 

The XCI_FC module provides a file cache for 3DEXPERIENCE export.  

If 3DEXPERIENCE export file caching is configured, XCI_FC must be deployed to a web application 

server as described in the next steps. 

3.2.2.1 Package 

Locate the package XCI_FC-<TCI Version>.webapp.zip (for example XCI_FC-3.9.0-01.zip) 

and unzip to temporary location. 

In the next steps we will move and edit some of the delivered files. 

3.2.2.2 XCI_FC_HOME directory 

Copy the XCI_FC_HOME directory from the software package to <TCI_INSTALL_DIR>.  

This directory will be the main working directory for the file cache. 

3.2.2.3 Tomcat: start script 

If XCI_FC is deployed in the same Tomcat as TCI, then edit the Tomcat start script described in 

previous chapter and set the XCI_FC_HOME variable. 
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If XCI_FC is deployed in a different Tomcat, create the start script as described next. 

Copy the sample start script start-fc-tomcat.bat.sample from the software package to 

<TCI_INSTALL_DIR> and remove the .sample file extension. This script is used to start Tomcat.   

Set the following environment variables in the start script. 

 

Environment Variable Example Value Description 

XCI_FC_HOME C:\TCI\XCI_FC_HOME XCI_FC home directory 

CATALINA_HOME C:\TCI\apache-tomcat-9.0.89 Tomcat Catalina home directory 

JRE_HOME C:\Program Files\Java\jre-17.0.11+9 JRE home directory 

JAVA_OPTS %JAVA_OPTS% -Xms128m -Xmx512m Additional Java Options 

Table 5: XCI_FC web application environment variables 

3.2.2.4 Deploy XCI_FC web application 

From the XCI_FC software package, copy the main application XCI_FC.war, to the webapps 

directory of the web application server: <CATALINA_HOME>\webapps. 

3.2.3 Setup XCI_CS as web application 

The XCI_CS module is used to distribute batch processing loads like COMRecon or XCI 

3DEXPERIENCE Batch to different hosts. 

If the XCI_CS is configured (usecs is true in one of the following settings: V5ToV6Preprocessing, 

V6ToV5Postprocessing, SendToXPDMProcessing, XPDMExportProcessing, XPDMImportProcessing, 

FolderExportProcessing, FolderImportProcessing, FileExportProcessing) the XCI_CS must be deployed to 

a web application server as described in the next steps. 

3.2.3.1 Package 

Locate the package XCI_CS-<TCI Version>.webapp.zip (for example XCI_CS-3.11.0.0.01. 

zip) and unzip to temporary location. 

In the next steps we will move and edit some of the delivered files. 

3.2.3.2 XCI_CS_HOME directory 

Copy the XCI_CS_HOME directory from the software package to <TCI_INSTALL_DIR>.  

This directory will be the main working directory for the file cache. 

3.2.3.3 Tomcat: start script 

If XCI_CS is deployed in the same Tomcat as TCI, then edit the Tomcat start script described in 

previous chapter and set the XCI_CS_HOME variable. 

If XCI_CS is deployed in a different Tomcat, create the start script as described next. 

Copy the sample start script start-cs-tomcat.bat.sample from the software package to 

<TCI_INSTALL_DIR> and remove the .sample file extension. This script is used to start Tomcat.   

Set the following environment variables in the start script. 
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Environment Variable Example Value Description 

XCI_CS_HOME C:\TCI\XCI_CS_HOME XCI_CS home directory 

CATALINA_HOME C:\TCI\apache-tomcat-9.0.89 Tomcat Catalina home directory 

JRE_HOME C:\Program Files\Java\jre-17.0.11+9 JRE home directory 

JAVA_OPTS %JAVA_OPTS% -Xms128m -Xmx512m Additional Java Options 

Table 6: XCI_CS web application environment variables 

3.2.3.4 Deploy XCI_CS web application 

From the XCI_CS software package, copy the main application XCI_CS.war, to the webapps 

directory of the web application server: <CATALINA_HOME>\webapps. 

3.3 TCI configuration 

After the installation TCI must be configured in the following configuration files in the installation 

directory. 

3.3.1 Logging configuration 

TCI will read and apply the log4j configuration from the following file in the XCI_HOME directory: 

 log4j2.xml 

By default, TCI will log to directory XCI_HOME\logs. 

If the configuration file is not present when starting TCI it will apply its embedded default 

configuration, logging only to the standard output. 

To reconfigure logging or changing the log directory please refer to 

https://logging.apache.org/log4j/2.x/.  

  

https://logging.apache.org/log4j/2.x/
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3.3.2 General TCI configuration 

The file XCISettings.xml in XCI_HOME defines all the functional settings for TCI. The settings file 

can be evaluated using the XCISettings.xsd file delivered with TCI. 

It is divided into the seven sections Conversion, Pdm, Teamcenter, Enovia, XciWeb, Features and 

Scheduler. 

In the next chapters the configuration of these sections will be described in detail. 

3.3.2.1 Conversion 

In the following chapters the configuration options for the tag Conversion are described. 

3.3.2.1.1 Database configuration 

TCI makes use of a database to store and keep track of required data. The used database must be 

configured using the resource definition of the application server. TCI will read the resource defined 

as “jdbc/xciDB”.  

The default resource can be overridden by defining the PersistenceUnitName in the settings 

(/XCISettings/Conversion/Database). 

<Database> 
<PersistenceUnitName>jdbc/myXciDB</PersistenceUnitName> 

</Database> 

 

The resource must be configured at the Tomcat application server in 

<CATALINA_HOME>/conf/context.xml. 

Example resource definition for Oracle: 

<Resource name="jdbc/xciDB" type="javax.sql.DataSource"  
 auth="Container" driverClassName="oracle.jdbc.OracleDriver"  
 maxTotal="100" maxIdle="10" maxWaitMillis="-1" 
 url="jdbc:oracle:thin:@my.db-server-url.com:1521:orcl"  
 username="XCI"  
 password="XCI" /> 
 

Example resource definition for MS SQL: 

<Resource name="jdbc/xciDB" type="javax.sql.DataSource"  
 auth="Container" driverClassName="com.microsoft.sqlserver.jdbc.SQLServerDriver"  
 maxTotal="100" maxIdle="10" maxWaitMillis="-1" 
 url=" jdbc:sqlserver://my.db-server-url.com\SQLEXPRESS;databaseName=XCI"  
 username="XCI"  
 password="XCI" /> 
 

Example resource definition for H2: 

<Resource name="jdbc/xciDB" type="javax.sql.DataSource"  
 auth="Container" driverClassName="org.h2.Driver"  
 maxTotal="100" maxIdle="10" maxWaitMillis="-1"  
 url="jdbc:h2:C:\XCI\XCI_HOME\xciDB\xciDB;AUTO_SERVER=TRUE"  
 username="XCI"  
 password="XCI" /> 
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If the resource is not defined at the application server, a local and file based H2DB will be created in 

the home directory. 

3.3.2.1.2 General settings 

<TempDir>C:\temp</TempDir> 

Optional definition of a temporary directory to be used by TCI. TCI must have read and write access 

to this directory. 

If the value is not defined the path “<TCI_HOME>\temp” will be used. 

 

<PersistentDir>C:\persistent</PersistentDir> 

Optional definition of a directory to be used by TCI to store persistent data. TCI must have read and 

write access to this directory.  

If the value is not defined the path “<TCI_HOME>\persistent” will be used. 

 

<RenameFilesAfterDownload>true</RenameFilesAfterDownload> 

Rename the files after download from Teamcenter to the value of the original_file_name 

attribute. 

The default setting is “true”. 

 

<RenameFileTypesAfterDownload enabled="true"> 
 <FileType>CATDrawing</FileType> 
</RenameFileTypesAfterDownload> 

List of file types which will be renamed to obid.extension, to support multiple objects with the 

same file name. Should only be used with file types which are not referenced by other files 

(CATDrawing, JT, etc.). This setting is ignored if RenameFilesAfterDownload preference is set to 

“false”. 

 

<ImportPdm enableLevelSplitUp="true"  
enableLevelSetBased="false"  
enableQueuing="false"  
timeoutQueuing="600000"  
enableLevelQueuing="true"  
timeoutLevelQueuing="600000" /> 

Strategy how to import the V6 structures to Teamcenter: 

enableLevelSplitUp: The default value is “false”. True will enable the split up of the Teamcenter 

import in a level-based import. 

enableLevelSetBased: The default value is “false”. True will enable the set-based approach for the 

import of one level. 

The level-based import will start at the deepest level nodes of the product structure and will first 

import these leave nodes, then the parent objects up to the top level are imported including the direct 

children. If enableLevelSetBased is set to “true” then the same levels are imported in one import 

process (using the set-based import), else each object is imported in its own import process. 
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enableQueuing: true will enable the functionality to not handle the same part number in parallel 

running PDM imports. 

timeoutQueuing: Timeout for the import queuing [ms]. Default value 10 minutes. 

enableLevelQueuing: true will enable the functionality to not handle the same part number in parallel 

running PDM level imports. 

timeoutLevelQueuing: Timeout for the import queuing [ms]. Default value 10 minutes. 

 

<ExportPdm enableQueuing="true"/> 

enableQueuing: true will enable the functionality to not handle the same part number in parallel 

running PDM exports. 

timeoutQueuing: Timeout for the export queuing [ms]. Default value (600000) 10 minutes. 

 

<Import3DX enableQueuing="true"/> 

enableQueuing: true will enable the functionality to not handle the same part number in parallel 

running 3DX imports. 

timeoutQueuing: Timeout for the import queuing [ms]. Default value (600000) 10 minutes. 

 

<DisablePdmImportSkipNotModified>true</DisablePdmImportSkipNotModified> 

To disable the skipping the import of objects to Teamcenter which are not modified since the last 

import, it must be set to “true”. 

The default setting is “false”. 

 

<LegacyTransformationSupport enabled="true" /> 

Enables the support for legacy transformation in Teamcenter if enabled is set to “true”. 

The default setting is “true”. 

 

<IgnoreNon3DPartGeometries enabled="true" /> 

Enables the ignoring of geometries which are not 3DPart in 3DEXPERIENCE if enabled is set to 

“true”. 

The default setting is “false”. 

3.3.2.1.3 PdmExportValidation definition 

< PdmExportValidation > 
 <AttributeCheck enabled="true"> 
  <XType xname ="Product"> 
   <XAttribute xname="Description" 
     mappingtype="DefaultCustomization" 
     maxlength="60" 
     truncate="true" /> 
  </XType> 
 </AttributeCheck> 
 <InstanceNameCheck enabled="true" /> 
 <FileRefCheck enabled="false" /> 
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 <FileNameCheck enabled="false" /> 
 <ProductLeafRepresentationCheck enabled="false" onlyWarning="true" /> 
 <RepNameCheck enabled="true" /> 
 <ValidateMainFileCount enabled="true" /> 
 <ValidateMissingFileForDocument enabled="true" /> 
 <ValidateMultipleReferencedDocument enabled="true" /> 
 <ValidateMultipleRevisions enabled="true" /> 
 <ValidateIncorrectRevisionSequence enabled="true" /> 
</ PdmExportValidation > 

Definition of the export checks. 

Each AttributeCheck must be enabled and disabled with the enabled attribute. The optional 

onlyWarning attribute can be set to “true” for each check. Then the check is handled as warning 

condition not as error condition. 

The AttributeCheck is used to check the maxlength attribute in the CustomAttribute (see chapter 

3.3.2.2.1) setting. 

Additionally, the standard attribute length can be checked. The example above shows the limitation 

of the “Description” to maximum length of “60”. If the maximum length of the attribute is defined, the 

truncate attribute flag enables the truncate functionality which will truncate the attribute to the 

maximum length. 

The InstanceNameCheck checks the uniqueness of instance name per parent object. 

The FileRefCheck checks the multiple use of a File Ref from different Objects. 

The FileNameCheck checks the uniqueness of file names in the files section. 

The ProductLeafRepresentationCheck checks the existence of an attached Representation at a 

Product node, if the Product node is a leaf node. 

The RepNameCheck checks for duplicate representation names. ID Attribute in Rep3D, Drawing, 

Document, and GenericDocument Object. 

The ValidateMainFileCount checks if more than one main file is attached. 

The ValidateMissingFileForDocument checks if a file for document is attached. 

The ValidateMultipleReferencedDocument checks if a document is referenced by more than one 

part. 

The ValidateMultipleRevisions checks if more than one revision of the same part is found. 

The ValidateIncorrectRevisionSequence checks if the revision sequence is correct. 

These five tags have the attributes enabled and onlyWarning. The attribute enabled is required. The 

attribute onlyWarning is optional and has the default “false”. 

3.3.2.1.4 PdmImportValidation Definition 

< PdmImportValidation > 
 <AttributeCheck enabled="true"> 
  <XType xname ="Product"> 
   <XAttribute xname="Description" 
     mappingtype="DefaultCustomization" 
     maxlength="60" 
     truncate="true" /> 
  </XType> 
 </AttributeCheck> 
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 <UnknownDocumentTypeStrategy>WARNING</UnknownDocumentTypeStrategy> 
</ PdmImportValidation > 

Definition of the import checks. 

See chapter 3.3.2.1.3 for details on AttributeCheck. 

The UnknownDocumentTypeStrategy defines the handling of unmapped document types during 
transfer. If there is no V6FileFormat available for the given fileextension, this setting will define how 
to handle the transfer. The following options are possible: 

• WARNING: Default. No unmapped files will be transferred. The transfer activity will finish in 
state “Warning” and more information can be found in the report. 

• ERROR: Unmapped files will cause the activity to fail! No data will be transferred. 

• IMPORT: Unmapped files will be transferred using the settings in GenericDocumentFormat. 
See chapter 3.3.2.1.10.1 for more information. No warning or error will be reported in the 
activity. 

 

3.3.2.1.5 Teamcenter Project definitions 

<Projects> 
 <DefaultProject name="Default"> 
  <ProjectName>Standard</ProjectName> 
  <Organization>Company Name</Organization> 
  <Owner>DemoDesigner</Owner> 
  <LifeCycle>VPLM_SMB</LifeCycle> 
  <Maturity>RELEASED</Maturity> 
  <MaturityNoStatus>IN_WORK</MaturityNoStatus> 
 </DefaultProject> 
</Projects> 

Definition of projects and the corresponding values for ProjectName, Organization, Owner, 

LifeCycle, Maturity and MaturityNoStatus. The Projects section must include one DefaultProject that 

will be used when no other defined project matches. 

The defined values for the projects define which values will be set to the items when sending them 

to 3DEXPERIENCE. If no project is defined or no values are defined for a project the values from 

the default project are used. 

The values for Organization and Owner can be left blank. These will be set to the values of the 

importing administration user on the 3DEXPERIENCE import. 

The value for MaturityNoStatus will be used for objects without status. If this value is not defined, the 

value for Maturity will be used. 

For the Non-CATIA document import the Maturities and LifeCycle can be defined for Document and 

GenericDocument types. 

The defaults for Document and GenericDocument types are: 

Default Document Maturity: Exists 

Default Document Lifecycle: Document 

Default GenericDocument Maturity: WIP 

Default GenericDocument Lifecycle: Controlled Production Release Rev2 

These defaults can be set in the Project settings: 

<DefaultProject name="Default"> 
 … 
 <DocumentLifeCycle>Document Release</DocumentLifeCycle> 
 <DocumentMaturity>RELEASED</DocumentMaturity> 
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 <DocumentMaturityNoStatus>IN_WORK</DocumentMaturityNoStatus> 
 <GeneralDocumentLifeCycle>Controlled Production Release Rev2</GeneralDocumentLifeCycle> 
 <GeneralDocumentMaturity>Released</GeneralDocumentMaturity> 
 <GeneralDocumentMaturityNoStatus>WIP</GeneralDocumentMaturityNoStatus> 
</DefaultProject> 

3.3.2.1.6 Teamcenter User and Group definitions 

<UserMappingForPdm owner="user1" group="Engineering"> 
 <AdditionalChangeOwnerObjectsForPdm> 
  <ExpandRelationType>IMAN_specification</ExpandRelationType> 
  <ExpandRelationType>IMAN_master_form</ExpandRelationType> 
  <ExpandType>CMI2Product</ExpandType> 
  <ExpandType>ItemRevision Master</ExpandType> 
 </AdditionalChangeOwnerObjectsForPdm> 
</UserMappingForPdm> 

The owner will be used for new objects in Teamcenter.  

Warning: This can cause access problems, if you want to transfer objects a second time to 

Teamcenter. If owner is not configured, the default Teamcenter behavior defines the owner. 

The group will be used for new objects in Teamcenter. If group is not configured, the default 

Teamcenter behavior defines the group. 

If AdditionalChangeOwnerObjectsForPdm is configured, all objects of the configured relation types 

ExpandRelationType and expand types ExpandType will be determined and also assigned to the 

Teamcenter owner and group. 

3.3.2.1.7 Teamcenter Item Revision cleanup setting 

<RevisionCleanupForPdm> 
 <cleanChildren enabled="true" bvrType="view" /> 
 <cleanDocuments enabled="true"> 
  <ExpandRelationType>IMAN_specification</ExpandRelationType> 
  <ExpandRelationType>IMAN_Rendering</ExpandRelationType> 
  <ExpandType>CMI2Part</ExpandType> 
  <ExpandType>CMI2Product</ExpandType> 
  <ExpandType>CMI2Drawing</ExpandType> 
  <ExpandType>DirectModel</ExpandType> 
 </cleanDocuments> 
</RevisionCleanupForPdm> 

If cleanChildren is enabled, all children are removed for new created Item Revisions during 

Teamcenter import. The default BVR type is “view” and can be configured by the bvrType attribute. 

The default for the enabled flag is “false”. 

If cleanDocuments is enabled, all documents configured by type (ExpandType) and relation 

(ExpandRelationType), are removed from new created Item Revisions during Teamcenter import. 

The default for the enabled flag is “false”. 

3.3.2.1.8 Revision mapping 

<PdmRevisionMapping >alphabetical</PdmRevisionMapping > 

The PdmRevisionMapping defines the revision numbers in Teamcenter as numerical or alphabetical. 

If PdmRevisionMapping is configured, TCI will perform a direct assignment between the revisions of 

Teamcenter and 3DEXPERIENCE via XPDMXML (e.g. Teamcenter revision “D” will be transferred 

as revisionindex “4” to 3DEXPERIENCE). As a result of this configuration, the revisions in 

Teamcenter or 3DEXPERIENCE may have gaps if only selected revisions are transferred. 
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If the PdmRevisionMapping is not configured the next free revision/index will be used. 

3.3.2.1.9 Document Revision mapping 

<PdmDocumentRevisionMapping>alphabetical</PdmDocumentRevisionMapping> 

The PdmDocumentRevisionMapping defines the revision numbers for documents in Teamcenter as 

numerical or alphabetical. 

If PdmDocumentRevisionMappingis configured, TCI will perform a direct assignment between the 

revisions of Teamcenter and 3DEXPERIENCE via XPDMXML (e.g. Teamcenter revision “D” will be 

transferred as revisionindex “4” to 3DEXPERIENCE). As a result of this configuration, the revisions 

in Teamcenter or 3DEXPERIENCE may have gaps if only selected revisions are transferred. 

If the PdmDocumentRevisionMapping is not configured the next free revision/index will be used. 

3.3.2.1.10 File type mapping definitions 

3.3.2.1.10.1 V6 to Teamcenter file type mapping 

<V6PdmFileType> 
<V6FileFormat v6format="CATPart"> 
 <Main> 
  <PdmDocType>CMI2Part</PdmDocType> 
  <PdmDocRelation>IMAN_specification</PdmDocRelation> 
  <PdmRefType>CATPart</PdmRefType> 
 </Main> 
 <Aux> 
  <PdmDocType>CMI2AuxPart</PdmDocType> 
  <PdmDocRelation>IMAN_specification</PdmDocRelation> 
  <PdmRefType>CATPart</PdmRefType> 
 </Aux> 
</V6FileFormat> 
<ImportFormat fileFormat = "PNG" v6PdmType="Rep3D"> 
 <PdmDocType>Image</PdmDocType> 
 <PdmDocRelation>IMAN_specification</PdmDocRelation> 
 <PdmRefType>Image</PdmRefType> 
</ImportFormat> 
<GenericDocumentFormat> 
 <PdmDocType>Text</PdmDocType> 
 <PdmDocRelation>IMAN_specification</PdmDocRelation> 
 <PdmRefType>Text</PdmRefType> 
</GenericDocumentFormat> 

</V6PdmFileType> 

The V6PdmFileType can contain multiple V6FileFormats defining how the specified file should be 

imported to Teamcenter. 

Each V6FileFormat defines a PdmDocType, a PdmDocRelation, and a PdmRefType in the Main 

section. The same is defined for Aux documents. The Aux definition is used for shared 

representations. 

The ImportFormat block defines additional files besides the main geometry file, for example images 

for thumbnails, or secondary geometry files, for example .dxf files for Drawings if the main file is 

.CATDrawing. 

For both V6FileFormat and ImportFormat the filename handling can additionally be controlled.  

• Set RemoveOrigExtensionForPdm to true if the original file extension should be removed 

from the filename, e.g. rename the image myfile.CATPart.png to myfile.png. Default is false. 
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• Set UseOrigFileNameForPdm to true to use the original filename as exported from 

3DEXPERIENCE. Default is false. 

• Set UseOrigFileNameForDocumentName to true to use the original filename as exported 

from 3DEXPERIENCE for the Document created in Teamcenter. Default is false. 

The GenericDocumentFormat defines, how unmapped document types will be handled, when the 

strategy is set to IMPORT (see chapter 3.3.2.1.4 for more details). 

3.3.2.1.10.2 Teamcenter to V6 file type mapping 

<PdmV6FileType> 
<V6Representation fileextension="CATPart" doctype="CMI2Part"> 
 <RepresentationType>Rep3D</RepresentationType> 
 <DerivedType>DirectModel</DerivedType> 
</V6Representation> 

 <V6Representation fileextension="prt.*" fileformat="Creo" doctype="CreoPart"> 
  <RepresentationType>Rep3D</RepresentationType> 
 </V6Representation> 
</PdmV6FileType> 

The PdmV6FileType can contain multiple V6Representations defining how the specified file should 

be exported from Teamcenter. The V6Representation has the optional attribute aux with default 

“false”. The fileextension can also contain wildcards. The fileformat can be used if the file extension 

is not the file format in the XPDMXML file. 

Each V6Representation defines a RepresentationType and a DerivedType. 

RepresentationType can be Drawing, Rep3D, Rep3DAndOriginalDocument, Product, 

ProductOrRep3D, Document, or GenericDocument. 

 

3.3.2.1.11 Customization registration 

<Customizations> 
<CustomizationPoint custpoint="com.tsystems.xci.customization.CustomizationPointX" 

entrypoint="my.customization.MyCustomizationPointImpl" /> 
</Customizations> 

The behavior of the integration can be modified using customization points. The Customizations tag 

may contain multiple CustomizationPoints defining which customization implementation should be 

used. Each CustomizationPoint defines a custpoint to be overridden and an entrypoint specifying 

the overriding implementation. The optional attribute enabled has the default “true”. 

It is not necessary to set a customization point. All customization points are implemented using the 

integration default behavior. 

If you require any kind of customization please contact the support team. 

3.3.2.1.12 SetTimeModified setting 

<SetTimeModified> 
<Rep3D disabled="true" /> 
<Drawing disabled="true" /> 
<Document disabled="true" /> 
<GenericDocument disabled="true" /> 
<ProductFile disabled="true" /> 
<Product disabled="true" /> 
<ProductInst disabled="true" /> 

</SetTimeModified> 
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The <TimeModified> tag is by default written to the <Rep3D>, <Rep3DAggr>, <Drawing>, 

<DrawingAggr>, <Document>, <GenericDocument>, <Product>, and <ProductInst> tags in the 

Metadata.xml import file. With this time information the import can skip already imported files and 

optimize the performance of the import process. 

This optimization can be disabled, e.g. to resolve multi model links in several contexts. 

SetTimeModified has the attribute enabled with default “true”. 

3.3.2.1.13 SharedFileTypeExtensions setting 

<SharedFileTypeExtensions> 
 <SharedFileTypeExtension>model</SharedFileTypeExtension> 
 <SharedFileTypeExtension>cgr</SharedFileTypeExtension> 
 <SharedFileTypeExtension>CATDrawing</SharedFileTypeExtension> 
</SharedFileTypeExtensions> 

Documents are by default written as Rep3DAggr or DrawingAggr object in the metadata.xml input 

file. All file extensions which are defined in the SharedFileTypeExtensions setting are written as 

shared object type Rep3DInst/Rep3D or DrawingInst/Drawing objects in the metadata.xml input 

file and they will be created as a shared object in the 3DEXPERIENCE. 

3.3.2.1.14 Exclusion List File settings 

<ExclusionListFile replaceWithDummy=”false”>C:\tmp\exclusionlist.xml</ExclusionListFile> 

Define ExclusionListFile containing ItemRevisions that should not be exported from Teamcenter. Set 

replaceWithDummy to true to replace excluded ItemRevisions with Dummy ItemRevision defined in 

DummyProductData setting. The Dummy will be imported into 3DEXPERIENCE. Please note, that 

every excluded ItemRevision will be replaced with the same Dummy ItemRevision. 

<DummyProductData> 

    <Type>ItemRevision</Type> 

    <ID>MyDummy</ID> 

    <Revision>1</Revision> 

    <Name>Replace</Name> 

    <Description>DummyPart for ExclusionList</Description> 

    <Owner>Owner</Owner> 

</DummyProductData> 

 

<ExclusionCATProductsListFile>C:\tmp\exclusioncplist.xml</ExclusionCATProductsListFile> 

The ExclusionCATProductsListFile is the exclusion list with the CAD objects for which the 

CATProduct files should be ignored. 

 

<TimeModifiedExclusionListFile 
removeTimeStamp="false">C:\tmp\exclusiontmlist.xml</TimeModifiedExclusionListFile> 

The TimeModifiedExclusionListFile is the exclusion list with the CAD objects for which the 

TimeModified tag should be changed/removed. The optional attribute removeTimeStamp has the 

default “false”. 

Example for an Exclusion list settings file. 



<Conversion> TCI configuration 

TCI Release 3.11 - Installation Manual 22 

<?xml version="1.0" encoding="ISO-8859-1" standalone="yes"?> 

<EL> 

 <ItemRev> 

  <Id>DREP2-TSI2-0001</Id> 

  <Type>Design Revision</Type> 

  <Revision>1</Revision> 

 </ItemRev> 

 <Item> 

  <Id>DREP2-TSI2-0001</Id> 

  <Type>Design Revision</Type> 

 </Item> 

</EL> 

3.3.2.1.15 V5ToV6Preprocessing setting 

<V5ToV6Preprocessing enabled="true"> 
 <V5PreprocessingCommand>C:\TCI\COMReconV5_R28\go\COMReconV5.bat 
C:\TCI\COMReconV5_R28\go\XCI_V5_V6.opt</V5PreprocessingCommand> 
</V5ToV6Preprocessing> 

The functionality for the V5 Preprocessing with COMReconV5 must be enabled to use the 

COMReconV5 tool from T-Systems. 

<V5ToV6Preprocessing enabled="true" 
    usecs="true"  
    tdsUrl="http://my.tci-integration-server.url:port/XCI/XCI_TDS"> 

 <V5PreprocessingHost local="false"> 
  <Url>http://my.tci-integration-server.url:port/XCI_CS</Url> 
  <Command>C:\TCI\COMReconV5_R28\go\COMReconV5.bat 
C:\TCI\COMReconV5_R28\go\XCI_V5_V6.opt</Command> 
 </V5PreprocessingHost> 
</V5ToV6Preprocessing> 

If usecs is set to “true” the V5PreprocessingHost setting is used. The timeout can be set with a 

Timeout sub-tag in the V5PreprocessingHost setting, the default value is 0 (no timeout). 

The timeout for the setup without Converter Server can be set by a timeout attribute in the 

V5PreprocessingCommand setting, the default value is 0 (no timeout). 

Details for tdsUrl please see in chapter 3.3.2.4.7. 

3.3.2.1.16 V6ToV5Postprocessing setting 

<V6ToV5Postprocessing enabled="true"> 
 <V6PostprocessingCommand>C:\TCI\COMReconV5_R28\go\COMReconV5.bat 
C:\TCI\COMReconV5_R28\go\XCI_V6_V5.opt</V6PostprocessingCommand> 
</V6ToV5Postprocessing> 

The functionality for the V6 Postprocessing with COMReconV5 must be enabled to use the 

COMReconV5 tool from T-Systems. 

<V6ToV5Postprocessing enabled="true" 
      usecs="true"  
      tdsUrl="http://my.tci-integration-server.url:port/XCI/XCI_TDS"> 

<V6PostprocessingHost local="false"> 
  <Url>http://my.tci-integration-server.url:port/XCI_CS</Url> 
  <Command>C:\TCI\COMReconV5_R28\go\COMReconV5.bat 
C:\TCI\COMReconV5_R28\go\XCI_V6_V5.opt</Command> 
 </V6PostprocessingHost> 
</V6ToV5Postprocessing> 
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If usecs is set to “true” the V6PostprocessingHost setting is used. The timeout can be set with a 

Timeout sub-tag in the V6PostprocessingHost setting, the default value is 0 (no timeout). 

The timeout for the setup without Converter Server can be set by a timeout attribute in the 

V6PostprocessingCommand setting, the default value is 0 (no timeout). 

Details for tdsUrl please see in chapter 3.3.2.4.7. 

3.3.2.1.17 CoexistenceXpdmXmlProcessing setting 

<CoexistenceXpdmXmlProcessing disabled="true" /> 

The coexistence processing functionality (remove of objects which are not controlled by XPDM) can 

be disabled with this setting. 

The default setting is “false”. 

3.3.2.1.18 DwcProductStructureExport setting 

<DwcProductStructureExport enabled="true" /> 

The downward compatibility product structure export functionality (export CATPart and CATProduct 

files from 3DEXPERIENCE with one call) can be enabled with this setting. 

The default setting is “false”. 

3.3.2.1.19 FileConversion setting 

The file conversion functionality (convert non importable file types to importable file types) can be 

enabled with this setting. 

Import without the Converter Server: 

<FileConversion enabled="true"> 
 <SingleFileConversionCommand inputtype="iges" outputtype="cgr"> 
  <Command>C:\converter\iges_cgr_converter.bat</Command> 
 </SingleFileConversionCommand> 
</FileConversion> 

The timeout can be set by a timeout attribute in the SingleFileConversionCommand setting, the 

default value is 0 (no timeout). 

Import with the use of the Converter Server: 

<FileConversion enabled="true" resource="CV" usecs="true" tdsUrl="http://my.tci-integration-
server.url:port/XCI/XCI_TDS"> 
 <FileConversionHost local="false"> 
  <Url>http://my.tci-integration-server.url:port/XCI_CS</Url> 
  <Command>Command1</Command> 
 </FileConversionHost> 
 <FileConversionCommand commandName="Command1"> 
  <ConversionCommand inputtype="iges" outputtype="cgr"> 
   <Command>C:\converter\iges_cgr_converter.bat</Command> 
  </ConversionCommand> 
 </FileConversionCommand> 
</FileConversion> 

The timeout can be set with a Timeout sub-tag in the FileConversionHost setting, the default value 

is 0 (no timeout). 

For configuration details, please see chapter 3.3.2.4.7. For all CS the same converter functionality 

must be available. 
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The following windows batch file can be used to start a third-party converter: 

REM get the input file path 

set INPUTFILE=%TCI_CONVERTINPUTFILE% 

REM get the output file path 

set OUTPUTFILE=%TCI_CONVERTOUTPUTFILE% 

 

if EXIST %INPUTFILE% GOTO CONTINUE1 

echo "cannot find >%INPUTFILE%<" 

GOTO END_ERROR 

:CONTINUE1 

 

if NOT EXIST %OUTPUTFILE% GOTO CONTINUE2 

del %OUTPUTFILE% 

:CONTINUE2 

 

echo "converting %INPUTFILE% to %OUTPUTFILE% 

 

REM call the converter 

converter.exe %INPUTFILE% %OUTPUTFILE% 

 

set retval=%ERRORLEVEL% 

 

:END 

exit /b %retval% 

 

:END_ERROR 

REM not equal 0 for error 

exit /b 1 

3.3.2.1.20 V6MaturityToPdmStatusMappingList setting 

<V6MaturityToPdmStatusMappingList enabled="true"> 
 <V6MaturityToPdmStatusMapping v6maturity="RELEASED" 
      pdmTyp=”Design Revision” 

pdmstatus="TCM Released" /> 
</V6MaturityToPdmStatusMappingList> 

The maturity status mapping list defines the mapping between the V6 Maturity and the Status object 

name in Teamcenter. When the functionality is enabled all 3DEXPERIENCE Objects with the 

Maturity defined in the v6maturity attribute will get a Status object with the name from the pdmstatus 

attribute. The attribute enabled has default “false”. 

3.3.2.1.21 PdmStatusUpdateHandling setting 

<PdmStatusUpdateHandling enabled="true"> 
 <AdditionalPdmStatusUpdate sourceType="Design Revision" 
      targetRelationType="IMAN_master_form" 
      targetObjectType="Design Revision Master" /> 
 <AdditionalPdmStatusUpdate sourceType="Design Revision" 
      targetRelationAttribute="structure_revisions" 
      targetObjectType="BOMView Revision" /> 
</PdmStatusUpdateHandling> 

Used to set the Item Revision Status to objects which are not directly mapped to a 

3DEXPERIENCE object, e.g. Master forms, BOMView Revisions, PDF document. 

The sourceType defines the Item Revision type under which the additional objects should be 

updated. The attribute enabled has default “false”. 
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If specified relation and target object are found below the source object, then the target object is 

mapped according to V6MaturityToPdmStatusMapping based on the maturity of the source object. 

If the target is not configured in V6MaturityToPdmStatusMapping, the status of the parent object is 

used. 

The example settings show an example for a Relation based setting (“IMAN_master_form”) and an 

Attribute based setting (“structure_revisions”). 

3.3.2.1.22 PdmStatusToV6MaturityMappingList setting 

<PdmStatusToV6MaturityMappingList enabled="true"> 
 <PdmStatusToV6MaturityMapping v6maturity="RELEASED" 
      pdmTyp=”Design Revision” 

pdmstatus="TCM Released" /> 
</PdmStatusToV6MaturityMapping> 

This status maturity mapping list defines the mapping between the Status object name in 

Teamcenter and the V6 Maturity. When the functionality is enabled, the Teamcenter ItemRevision 

objects of the type pdmTyp with the release status pdmstatus will get the v6maturity in 

3DEXPERIENCE. To define the mapping for Dataset objects, the pdmstatus of the parent 

ItemRevision must be used in this setting and can be mapped to a different v6maturity. 

The attribute enabled has default “false”. 

3.3.2.1.23 UseXidFromOccId setting 

<UseXidFromOccId>true</UseXidFromOccId> 

Use the Occurence ID for the Instance XID generation and only the instance name for identification 

of instances. If the setting is “true” but the child does not match the last known child, the instance is 

marked for a post processing task to correct the children in 3DEXPERIENCE. 

The default setting is “false”. 

3.3.2.1.24 CleanupPersistentDir setting 

<CleanupPersistentDir>true</CleanupPersistentDir> 

Used to clean up the persistent directory when the content is successfully transferred. 

The default setting is “false”. 

3.3.2.1.25 CleanupReportDirDaysToKeep setting 

< CleanupReportDirDaysToKeep>30</ CleanupReportDirDaysToKeep> 

Used to clean up the report directory, the CleanupReportDirDaysToKeep value is the number of 

days to keep the reports in the Report directory. -1 means cleanup disabled. 

The default setting is “-1”. 

3.3.2.1.26 RenameDuplicateInstanceNames setting 

<RenameDuplicateInstanceNames>true</RenameDuplicateInstanceNames> 

Used to rename duplicate instance names. Duplicates will be renamed to the Object Id of the relation. 

The default setting is “false”. 

3.3.2.1.27 CopyInstanceOrderNumberToV6 setting 

<CopyInstanceOrderNumberToV6>false</CopyInstanceOrderNumberToV6> 

The default setting is “true”. 
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3.3.2.1.28 TDXExportMode setting 

<TDXExportMode>ExportXPDM</TDXExportMode> 

The 3DXExportMode can be configured. 

Possible values are: 

▪ ExportXPDM: Direct export of a structure from 3DEXPERIENCE using the ExportBatch 

utility. 

▪ ExportFiles: Direct export of a structure from 3DEXPERIENCE using the DWC utility. 

▪ ExportDesign: Direct export of a structure from 3DEXperience using the Rest API. 

▪ ExportStepx (DS Cloud only): Direct export of a structure from 3DEXperience using the 

Enterprise IP Exchange service. 

Default setting is “ExportFiles”. 

3.3.2.1.29 TDXImportMode setting 

<TDXImportMode>ImportXPDM</TDXImportMode> 

The 3DXImportMode can be configured. 

Possible values are: 

▪ ImportXPDM: Direct import of a structure to 3DEXPERIENCE using the ImportBatch utility. 

▪ ImportDesign (DS Cloud only): Direct import of a structure to 3DEXPERIENCE using the 

Enterprise IP Exchange service. 

Default setting is “ImportXPDM”. 

3.3.2.1.30 ProcessStatusOnlySessionUser setting 

<ProcessStatusOnlySessionUser>true</ProcessStatusOnlySessionUser> 

Filter the result of the ProcessStatus by the actual session user. 

The default setting is “true”. 

3.3.2.1.31 ProcessStatusMaxReturn setting 

<ProcessStatusMaxReturn>50</ProcessStatusMaxReturn> 

The maximum number of ProcessStatus information to return for the ProcessStatus command. 

The default setting is “50”. 

3.3.2.1.32 ProcessStatusMaxDuration setting 

<ProcessStatusMaxDuration>P7D</ProcessStatusMaxDuration> 

The search period until now used to search for ProcessStatus information for the ProcessStatus 

command. 

The default setting is “P7D”. 

3.3.2.1.33 ReceiverMaxEventNumber setting 

<ReceiverMaxEventNumber>5</ReceiverMaxEventNumber> 

The maximum number of the events to handle. Minimum is “1”. A restart is needed to use the new 

value. 

The default setting is “1”. 
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3.3.2.1.34 ReceiverThreadPoolSize setting 

<ReceiverThreadPoolSize>10</ReceiverThreadPoolSize> 

The size of the Receiver thread pool. Minimum is “1”. A restart is needed to use the new value. 

The default setting is “1”. 

3.3.2.1.35 JobReceiverThreadPoolSize setting 

<JobReceiverThreadPoolSize>10</ JobReceiverThreadPoolSize> 

The size of the Job Receiver thread pool. Minimum is “3”. Restart needed to use the new value. 

The default setting is “5”. 

3.3.2.1.36 JobReceiverComplexThreadPoolSize setting 

<JobReceiverComplexThreadPoolSize>6</JobReceiverComplexThreadPoolSize> 

The size of the Job Receiver complex thread pool (used for Folder transfers). Minimum is 1. Restart 

needed to use the new value. 

The default setting is “3”. 

3.3.2.1.37 FolderNamingConcatenation setting 

<FolderNamingConcatenation enabled="true">_</FolderNamingConcatenation> 

Set enabled to “true” to build the new folder name in PDM from Root Folder Name, this setting, 

and the Folder Name. 

The attribute enabled has default “false”. 

3.3.2.1.38 ReconciliationMode setting 

<ReconciliationMode>xPDMMaster</ReconciliationMode> 

The Reconciliation Mode can be defined. 

Possible values are: 

▪ CATProductMaster: Use CATProduct structure information. 

▪ xPDMMaster: Use XPDMXML structure information. 

The default setting is CATProductMaster. 

3.3.2.1.39 ConverterService Resource Balancing definition 

<CSResourceBalancer> 
<Resource> 

<Name>V6</Name> 
<MaxParallel>2</MaxParallel> 

</Resource> 
</CSResourceBalancer> 

Limits concurrent use of resources across all Converter Server hosts. Resource can be licenses etc. 

and is identified by a string. 

Resources are then applied to different Processing Host types. 

The resource names can be defined with the Resource attribute at the processing settings. 

3.3.2.1.40 PartNumberMapping definition 

<PartNumberMapping enabled="true"> 
 <Default> 
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  <To3DXPrefix>TCI_</To3DXPrefix> 
 </Default> 
 <TypeMapping typePDM="MyItemRevision"> 
  <Mapping> 
   <To3DXPrefix/> 
   <To3DXPostfix/> 
   <ToPDMPrefix/> 
   <ToPDMPostfix/> 
  </Mapping> 
 </TypeMapping> 
</PartNumberMapping> 

The part number mapping is used to add pre and postfixes to part numbers in PDM and 3DX. The 

definition can be set for all types in the default section, or for types defined with TypeMapping. The 

new mapping will only be used for new transfers, the old mapping from the database is used before 

using this part number mapping. 

The attribute enabled has default “false”. 

3.3.2.1.41 SetFilterIn3DX setting 

<SetFilterIn3DX>true</SetFilterIn3DX> 

Set SetFilterIn3DX to “true” to enable the functionality to set filter in 3DX when sending structure 

names. 

The default for SetFilterIn3DX is “true”. 

See also TCIXpgPostProcess_SETFILTER setting in TCI XPGPostprocessing. 

3.3.2.1.42 StoreNamedStructuresetting 

<StoreNamedStructure>false</StoreNamedStructure> 

Set StoreNamedStructure to “true” to enable the functionality to store named structures. 

The default for StoreNamedStructure is “false”. 

3.3.2.1.43 HandleAuxFileAsMainFile 

<HandleAuxFileAsMainFile>true</HandleAuxFileAsMainFile> 

Set HandleAuxFileAsMainFile to “true” to handle auxiliary files like main files -> Create Product 

and Rep3DAggr in XpdmXml. 

The default for HandleAuxFileAsMainFile is “false”. 

3.3.2.1.44 JobRetrySeconds 

<JobRetrySeconds>0</JobRetrySeconds> 

The number of seconds to wait for the Job retry if the job fails. 0 will disable the retry. 

The default for JobRetrySeconds is “30”. 

3.3.2.1.45 SkipRepWithoutFile 

<SkipRepWithoutFile>false</SkipRepWithoutFile > 

True to remove Representations without file -> no document without file. 

The default for SkipRepWithoutFile is false. 

3.3.2.1.46 OverwriteReleasedWithForce 

<OverwriteReleasedWithForce>false</OverwriteReleasedWithForce> 

True to update released objects if force is true. 
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The default for OverwriteReleasedWithForce is false. 

3.3.2.1.47 JobQueuing 

<JobQueuing enabled="true" timeout="1200000"/> 

Set the enabled attribute to true to enable the job queuing. Enabled Job Queuing is used to not 

work on the same persistent directory in parallel. The default for JobQueuing enabled attribute is 

false. 

The timeout attribute defines the timeout for the queuing in milliseconds. If the timeout is reached 

the Job is started. The default for timeout is 1 hour (3600000 milliseconds). 

3.3.2.1.48 TypeMapping 

<TypeMapping enabled="true"> 
 <V6ToPdm> 
  <Mapping v6Type="VPMReference" pdmType="ItemRevision"/> 
  <Mapping v6Type=" VPMReference" pdmType="Design Revision"/> 
 </V6ToPdm> 
 <PdmToV6> 
  <Mapping v6Type="VPMReference" pdmType="ItemRevision"/> 
  <Mapping v6Type=" VPMReference" pdmType="Design Revision"/> 
 </PdmToV6> 
</TypeMapping> 

Set the enabled attribute to true to enable the type mapping. Enabled Type Mapping is used to 

define the Type mapping between 3DEXPERIENCE and Teamcenter. 

3.3.2.1.49 Part3DTypeList 

<Part3DTypeList> 
 <Part3DType>CATPart</Part3DType> 

</Part3DTypeList> 

List of types which should become Part3D product type, the default is 'CATPart'. 

3.3.2.1.50 V6CollaborativeSpaceToPdmProjectMapping 

<V6CollaborativeSpaceToPdmProjectMapping enabled="true" 
removeFromNotMappedProjects="true"> 

<CollaborativeSpace name="TCI"> 
<Project>ProjectA</Project> 

</CollaborativeSpace> 
<CollaborativeSpace name="Common Space"> 

<Project>ProjectA</Project> 
<Project>ProjectB</Project> 

</CollaborativeSpace> 
</V6CollaborativeSpaceToPdmProjectMapping> 

Map 3DEXPERIENCE collaborative spaces to Teamcenter projects when transferring objects from 

3DEXPERIENCE to Teamcenter. Based on the owning collaborative space in 3DEXPERIENCE, one 

or multiple Projects can be assigned in Teamcenter. 

If an object is already assigned to the mapped Project, the assignment operation is skipped. 

If removeFromNotMappedProjects is set to true, then objects will be removed from Projects in 

Teamcenter if the respective Projects is not mapped. Default is false. 
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3.3.2.1.51 Fastener 

<Fastener> 
    <ConvertToAssembly>false</ConvertToAssembly> 
</Fastener> 
 

On 3DEXPERIENCE export, convert Fastener to assembly products to process them the same way 

as Physical Products. Default is false. 

3.3.2.1.52 Unit Conversion 

<UnitConversionDefinition> 

    <UnitConversionname="kelvinToFahrenheit" unit="F" > 

        <Multiplier>1.7999999999999985600000000000012</Multiplier> 

        <Offset>-459.66999999999923226400000000061</Offset>   

    </UnitConversion> 

    <UnitConversion name="FahrenheitToKelvin" unit="K" > 

        <Multiplier>0.555555555555556</Multiplier> 

        <Offset>255.372222222222</Offset> 

    </UnitConversion> 

</UnitConversionDefinition> 

 

Defines a list of conversions between different units to be applied during Teamcenter import or 

3DEXPERIENCE import. Attributes exported from the source system might not be exported in the 

unit which is displayed in the user interface. For example, in 3DEXPERIENCE an attribute with input 

unit “cm” is exported with unit “m”. 

Conversion calculation: new_value = old_value * multiplier + offset. 

The unit conversions are applied during import of custom attributes in Teamcenter or 

3DEXPERIENCE when the conversion is specified in the CustomAttributeMapping (see section for 

Teamcenter 3.3.2.2.1 and section 3.3.2.4.8 for 3DEXPERIENCE import). 
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3.3.2.2 Pdm 

3.3.2.2.1 Custom Attribute Mapping 

<CustomAttributeMapping enabled="true"> 
<CustomObject xname="Product" 

  type="ItemRevision"  
  mappingtype="DefaultCustomization"> 
<CustomAttribute  xname="Description"  
   name="object_desc"  
   type="string"  
   export="true"  
   import="false" /> 
<CustomFormAttributes formtype="ItemRevision Master"  
    relationname="IMAN_master_form_rev"> 
 <CustomAttribute  xname="Supplier Name"  
    name="user_data_1"  
    type="string"  

     export="true"  
    import="true" 

maxlength="128" 
truncate="true" 
defaultValue="FavoriteSupplier" /> 

</CustomFormAttributes> 
</CustomObject> 

</CustomAttributeMapping> 

Definition of the custom attribute mapping. 

Each element defines the xname and the name. 

The xname defines the name of the XPDMXML custom property to use. 

The name defines the name of the Teamcenter property to use. 

<CustomAttributeMapping> 

The mapping can be switched on or off using the enabled attribute. 

It can contain multiple CustomObject definitions. 

<CustomObject> 

Each object definition can contain multiple CustomAttribute and CustomFormAttributes definitions. 

<CustomAttribute> 

The type defines the data type of the property to use. 

The direction of the mappings is defined independently by the import/export attributes for each 

CustomAttribute. If import is “true” the attribute will be imported to Teamcenter. If export is “true” the 

attribute will be exported from Teamcenter. 

The optional integer attribute maxlength defines the maximum length of the attribute. If the maximum 

length of the attribute is defined, the truncate attribute flag enables the truncate functionality which 

will truncate the attribute to the maximum length. This is checked if the setting AttributeCheck (see 

chapter 3.3.2.1.3) is enabled. 

The optional attribute defaultValue defines a default value to set on import if the attribute is empty. 

Optional attribute unitConversionImport can be set to convert the attribute value to a different unit 

on Teamcenter import. Set attribute to name of a conversion as defined in UnitConversionDefinition 

(see section 3.3.2.1.52). 
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<CustomFormAttributes> 

The CustomFormAttributes tag can be used to refer not the Teamcenter object defined in the 

CustomAttribute but to a formtype attached to in with the specified relationname. 

It can contain multiple CustomAttribute definitions. 

3.3.2.2.2 MetaUpdate 

<MetaUpdate enabled="true"> 
 <MetaObject type="ItemRevision"> 
  <MetaAttribute name="object_name" v6name="attribute[PLMEntity.V_Name]"/> 
  <MetaFormAttributes formtype="ItemRevision Master" relationname="IMAN_master_form_rev"> 
   <MetaAttribute name="user_data_1" v6name="attribute[PLMEntity.V_description]"/> 
  </MetaFormAttributes> 
 </MetaObject> 
 <MetaObject type="Design Revision"> 
  <MetaAttribute name="object_desc" v6name="attribute[PLMEntity.V_description]"/> 
  <MetaAttribute name="object_name" v6name="attribute[PLMEntity.V_Name]"/> 
 </MetaObject> 
</MetaUpdate>  

The MetaUpdate section defines the Teamcenter and 3DEXPERIENCE attributes for the metadata 

update command. The meta update functionality can be switched on or off using the enabled 

attribute.  

MetaObject defines the Teamcenter type with the type attribute. The MetaAttribute defines the attributes 

for the update functionality. 

• name: the attribute name in Teamcenter. 

• v6name: the 3DEXPERIENCE attribute name 

With the MetaFormAttributes attached forms with attributes can be used for the meta update. the 

formtype defines the type of the form and the relationname defines the relation name between the 

Revision and the Form. 

3.3.2.2.3 Configuration settings 

Settings for the configuration import in Teamcenter. 

<Configuration> 

 <ModelMapping name="X021"> 

  <ItemId>X021-config</ItemId> 

  <Revision>A</Revision> 

 </ModelMapping> 

 <ModelMapping name="X120"> 

  <ItemId>X120-config</ItemId> 

  <RevisionRuleUid>QkqJD2AWr9tFBC</RevisionRuleUid> 

 </ModelMapping> 

 <UpdateModel>true</UpdateModel> 

</Configuration> 

Defines the model mapping from 3DEXPERIENCE to Teamcenter. 

The ModelMapping name attribute defines the model name from 3DEXPERIENCE. 

The Teamcenter Item Revision configuration object can be defined statically with Item id and 

Revision or dynamically with ItemId and Revision Rule UID. The configuration object is used to store 

the Variant Rules and Options. 
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UpdateModel set to true will update the configuration object with the configuration effectivity transfer. 

3.3.2.2.4 Other Pdm settings 

<TemplateProductImport enabled="true">TemplateProduct.CATProduct</TemplateProductImport> 

The location of the template product file to use on import. The product file will be added on the fly in 

Teamcenter imports. The location may be relative to the TCI_HOME directory or an absolute path. 

The format of the template file to be used must be defined in the V6 to TC file type mapping at 

/XCISettings/Conversion/V6TcFileType as V6FileFormat. 

If the created product is required to get the same status as the parent object, this needs to be 

configured in /XCISettings/Conversion/StatusUpdateHandling like 

<AdditionalStatusUpdate  sourceType="F_GenericObj Revision"  
     targetRelationType="IMAN_specification"  
     targetObjectType="CATProduct" />. 

 

<ReallyRemoveExistingNotProvided enabled="true" /> 

Setting whether to remove unknown occurrences in Teamcenter or not. 

Default setting is “false”. 

 

<OverwriteOriginal enabled="true" /> 

Set enabled to “false” to prevent overwriting of data originating from Teamcenter (after CLOC). 

Default setting is “true”. 

 

<FileUploadChunkSize>1</FileUploadChunkSize> 
<FileDownloadChunkSize>1</FileDownloadChunkSize> 

Optional definition of the chunk sizes to be used to up- and download files using the Teamcenter 

FCS. 

The default settings are “1” each. 

 

<GetPropertiesChunkSize>1000</GetPropertiesChunkSize> 
<ExpandChunkSize>1000</ExpandChunkSize> 
<RefreshChunkSize>1000</RefreshChunkSize> 

Optional definition of the maximal chunk sizes to use when requesting metadata from the 

Teamcenter server. 

The default settings are “1000” each. 

Warning: Modifying these settings can affect the performance of the tool and die utilization of the 

Teamcenter server. 

 

<DocumentRelations> 

<Relation>IMAN_specification</Relation> 

<Relation>IMAN_Rendering</Relation> 

</DocumentRelations> 

Defines the relation types to be followed to documents when the export functionality of TCI is used. 



<Pdm> TCI configuration 

TCI Release 3.11 - Installation Manual 34 

 

<CreatePartClass>Item</CreatePartClass> 

Name of the Teamcenter Item type to use.  

The default class is “Item”. This behavior can be changed by overwriting the 

com.tsystems.xci.customization.CustomPartType class. 

 

<CreateFastenerPartClass>WeldPoint</CreateFastenerPartClass> 

Name of the Teamcenter Item type to use for Fastener items.  

The default is “WeldPoint”. This behavior can be changed by overwriting the 

com.tsystems.xci.customization.CustomItemType class. 

 

<LinkedDrawingHandling enabled="true"> 

 <LinkedDrawingDocumentType>CATDrawing</LinkedDrawingDocumentType> 

 <LinkedDrawingDocumentRelationType>IMAN_external_object_link</LinkedDrawingDocu

mentRelationType> 

</LinkedDrawingHandling> 

Defines a list of Teamcenter drawing Document types which should be searched as referenced at 

Item Revisions. The TCIC integration uses links for the drawing handling in Teamcenter. If the 

LinkedDrawingHandling is enabled the integration searches for referenced drawings and transfers 

these drawings to 3DEXPERIENCE. 

Default setting is “false”. 

 

<LinkedRevisionHandling enabled="true"> 

 <LinkType>IMAN_external_object_link</LinkType> 

</LinkedRevisionHandling> 

Defines a list of Teamcenter link types which should be used to search for referenced Item Revisions 

related to Documents. The TCIC integration uses links for the drawing handling in Teamcenter. If 

the LinkedRevisionHandling is enabled the integration searches for referenced Item Revisions and 

transfers these Item Revisions to 3DEXPERIENCE. 

Default setting is “false”. 

 

<Dispatchers> 
 <Dispatcher enabled="true"> 
  <DocumentType>CMI2Part</DocumentType> 

<FileType>CATPart</FileType> 
  <Provider>TSYSTEMS</Provider> 
  <Priority>3</Priority> 
  <Servicename>cmitojt</Servicename> 
  <Type>ONDEMAND</Type> 
 </Dispatcher> 
 <Dispatcher enabled="true"> 
  <DocumentType>CMI2Drawing</DocumentType> 
  <FileType>CATDrawing</FileType> 
  <Provider>TSYSTEMS</Provider> 
  <Priority>3</Priority> 
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  <Servicename>cmitopdf</Servicename> 
  <Type>ONDEMAND</Type> 
 </Dispatcher> 
</Dispatchers> 

Definitions for optional dispatchers to use. Each dispatcher can be enabled separately. 

 

<RevisionQuerySettings> 
 <RevisionTypes> 
  <!-- Use empty RevisionType for search all types. --> 
  <RevisionType/> 
  <RevisionType>ItemRevision</RevisionType> 
  <RevisionType>Design Revision</RevisionType> 
  <RevisionType>Part Revision</RevisionType> 
 </RevisionTypes> 
 <!--  The RevisionAttributeName must be the "User Entry Name" in the Query definition --> 
 <!--  of the Teamcenter Query Builder application. --> 
 <!--  for the item_id attribute e.g.: "Item ID" --> 
 <RevisionAttributeNames> 
  <RevisionAttributeName display="Item ID" >Item ID</RevisionAttributeName> 
  <RevisionAttributeName display="Item Revision" >Revision</RevisionAttributeName> 
  <RevisionAttributeName display="Name" >Name</RevisionAttributeName> 
  <RevisionAttributeName display="Description" >Description</RevisionAttributeName> 
 </RevisionAttributeNames> 
 <!-- if ResultAttributeNames tag does not exist, then all not empty attributes are returned. --> 
 <ResultAttributeNames> 
  <ResultAttributeName>item_id</ResultAttributeName> 
  <ResultAttributeName>item_revision_id</ResultAttributeName> 
  <ResultAttributeName>sequence_id</ResultAttributeName> 
  <ResultAttributeName>creation_date</ResultAttributeName> 
  <ResultAttributeName>owning_user</ResultAttributeName> 
  <ResultAttributeName>owning_group</ResultAttributeName> 
  <ResultAttributeName>last_mod_user</ResultAttributeName> 
  <ResultAttributeName>last_mod_date</ResultAttributeName> 
  <ResultAttributeName>checked_out_user</ResultAttributeName> 
 </ResultAttributeNames> 
 <MaxResultToReturn>25</MaxResultToReturn> 
</RevisionQuerySettings> 

RevisionTypes defines the settings for the Teamcenter Item Query. 

Use empty RevisionType for search all types. 

The RevisionAttributeName must be the “User Entry Name” in the Query definition of the Teamcenter 
Query Builder application. 
Example: 

The “item_id” attribute “Item ID” 

If the ResultAttributeNames tag does not exist, then all not empty attributes are returned. 

MaxResultToReturn sets a specified maximum number of matches to be returned. It has default “0”, 

which means no limit. 

 

<GetMetadataSettings> 

 <!-- used as default for all ItemRevision with subclasses -->  

 <ResultAttributeNames pdmType="ItemRevision"> 

  <ResultAttributeName>item_id</ResultAttributeName> 

  <ResultAttributeName>item_revision_id</ResultAttributeName> 

  <ResultAttributeName>creation_date</ResultAttributeName> 
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  <ResultAttributeName>last_mod_date</ResultAttributeName> 

  <ResultAttributeName>object_type</ResultAttributeName> 

  <ResultAttributeName>object_name</ResultAttributeName> 

  <ResultAttributeName>object_desc</ResultAttributeName> 

  <ResultAttributeName>owning_user</ResultAttributeName> 

  <ResultAttributeName>owning_group</ResultAttributeName> 

  <ResultAttributeName>owning_site</ResultAttributeName> 

 </ResultAttributeNames> 

 <!-- used as default for all Document with subclasses -->  

 <ResultAttributeNames pdmType="Dataset"> 

  <ResultAttributeName>creation_date</ResultAttributeName> 

  <ResultAttributeName>last_mod_date</ResultAttributeName> 

  <ResultAttributeName>object_type</ResultAttributeName> 

  <ResultAttributeName>object_name</ResultAttributeName> 

  <ResultAttributeName>object_desc</ResultAttributeName> 

  <ResultAttributeName>owning_user</ResultAttributeName> 

  <ResultAttributeName>owning_group</ResultAttributeName> 

  <ResultAttributeName>owning_site</ResultAttributeName> 

 </ResultAttributeNames> 

 <!-- used for CMI2Part class -->  

 <ResultAttributeNames pdmType="CMI2Part"> 

  <ResultAttributeName>last_mod_date</ResultAttributeName> 

  <ResultAttributeName>object_name</ResultAttributeName> 

  <ResultAttributeName>object_desc</ResultAttributeName> 

  <ResultAttributeName>owning_user</ResultAttributeName> 

  <ResultAttributeName>owning_group</ResultAttributeName> 

 </ResultAttributeNames> 

</GetMetadataSettings> 

GetMetadataSettings defines the attributes which are returned from the Show Teamcenter Attributes 

command in the TCI 3DEXPERIENCE Rich Client. 

<SendJobNotifications enabled="true"/> 

If the SendJobNotifications is enabled, the User receives a Message in the Teamcenter Mail system 

after the Job is finished. 

<ExportWithStateFilter enabled="true">Frozen,Released</ExportWithStateFilter> 

If enabled only objects with the configured state are exported from Teamcenter. The value is a 

comma separated list of allowed states. 

<HoldConnectionOpenInSeconds>60</HoldConnectionOpenInSeconds> 

Seconds to keep the Teamcenter service connection open while waiting for new service connection 

request. The default value is 60. 

<StructureCompare3DXRevRuleUid>QokBHeBxZN8TTB<StructureCompare3DXRevRuleUid> 

Revision rule to use when expanding structure for comparison with 3DEXPERIENCE structure. 

<ReportReceiverList enabled="false"> 

<Receiver>myTCIUser1</Receiver> 

<Receiver>infodba</Receiver> 

</ReportReceiverList> 
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Defines a list of Teamcenter users to receive reports on TCI actions. The reports will be delivered 

through Teamcenter to the mailbox of the defined users. The dataset type and the named reference 

for the report Document can be configured with the following settings. Default setting is “true”. 

<DocumentRevisionSeparator>/<DocumentRevisionSeparator> 

In Teamcenter, the revision may be part of the dataset name. (e.g. 000123/B). If the dataset is copied 

with each revision, but the name changes to include the new revision (e.g. 000123/C), the mapped 

name in V6 would change as well. To get consistent naming, this separator can be defined. The 

dataset name will be split at the last occurrence of the configured separator and the revision will be 

discarded when naming the document in V6. 
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3.3.2.3 Teamcenter 

In the following chapters the configuration options for the tag Teamcenter are described. 

3.3.2.3.1 Teamcenter Server definitions 

<Server> 
 <Url>http://my.tc-server.url:8080/tc</Url> 
 <Username>myTCIUser</Username> 
 <Password plaintext="true">myTCIPassword</Password> 
 <Group></Group> 
 <Role></Role> 
</Server> 

Definition of the Teamcenter server and the login credentials of the TCI user. 

The Username and the Password belong to an existing Teamcenter user. You can also specify the 

Group and Role in which the user will act. An optional element is Locale to define the required locale 

for the user. Another optional element is UseBypass, set it to true to set the bypass to the user. The 

element WaitForWarmServer defines the time to wait for a warming server in ms, the default value 

is 5000. 

3.3.2.3.2 Server Password 

The password in the XCISettings.xml (/XCISettings/Teamcenter/Server/Password) can be 

stored as plain text or encrypted. 

<Password plaintext="true">myTCIPassword</Password> 

To encrypt the password for TCI the following script can be used: 

set XCI_HOME=C:\XCI\XCI_HOME 

set WEBAPPS_FOLDER=C:\XCI\apache-tomcat-8.5.50\webapps 

set WEB_APP_NAME=XCI 

 

set JAVA_HOME= C:\Program Files\Eclipse Adoptium\jdk-11.0.14.101-hotspot 

set JDK_JAVA_OPTIONS=%JDK_JAVA_OPTIONS% -Djlicman.platform="Windows_2003_amd64" 

set 

CLASSPATH=D:\TC\TC14\soa_client\java\libs\*;D:\TC\TC14\soa_client\java\libs\com.

teamcenter.rac.external_14000.0.0\*;%WEBAPPS_FOLDER%\%WEB_APP_NAME%\WEB-

INF\lib\*;%WEBAPPS_FOLDER%\%WEB_APP_NAME%\WEB-INF\classes 

 

"%JAVA_HOME%\bin\java.exe" com.tsystems.xci.Main --encryptPassword 

 

pause 

TCI will prompt the user to enter the password. The password will only be written out to the standard 

output and must be copied to the configuration file manually. 

The command will generate a file named passwordKey and the encrypted password, that is printed 

to the command line. 

Note: 

If the passwordKey file exists it will not be overwritten. 

The encrypted password may differ after each execution of the encryption. It can be set as follows. 

<Password plaintext="false">INdlaJZMaTQO0MblX+/C1Q==</Password> 
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3.3.2.3.3 Teamcenter SessionPool settings 

<SessionPool enabled="true"> 

 <Login enabled="false" /> 

 <DiscardOnFailedLogin enabled="false" /> 

 <Logout enabled="false" /> 

 <!-- 60 min session timeout (3600000) --> 

 <DiscardIdle enabled="true">3600000</DiscardIdle> 

 <DiscardUsed enabled="false">100</DiscardUsed> 

</SessionPool> 

Defines the Session Pool handling. The session pool holds connections to Teamcenter open and 

uses this connection to login and logout with the Teamcenter Server. 

▪ Sessions are created as needed.  

▪ If Login is not enabled logins will only be issued on new created connections, but not on 

previously suspended connections. The default setting is “true”. 

▪ If Logout is not enabled logouts without discarding the session are suppressed. The default 

setting is “true”. 

▪ If DiscardOnFailedLogin is enabled connections will be discarded when a TC session login 

fails on them otherwise not. The default setting is “true”. 

▪ When a new session (using the same server, user, group and role) is needed the dormant 

connection will be reused. 

▪ If DiscardIdle is enabled a cyclic check will be executed to log out sessions that are idle for 

the timeout defined in the setting. The default setting is “false”. 

▪ If DiscardUsed is enabled connection will be discarded after the defined number of virtual TC 

sessions has used the connection. The default setting is “false”. 

3.3.2.3.4 Teamcenter FileManagement settings 

<FileManagement useFsc="true"> 
 <!-- ClientIPAddress is empty --> 
 <AssignedFSCURIs>http://fschost:fsc-port/</AssignedFSCURIs> 
 <!-- BootstrapFSCURIs is empty --> 
</FileManagement> 

If the useFsc is set to true, the tccs is not used, but the direct connection to the fsc is used. 

Define FileManagementUtility to use with parameters:  

• ClientIPAddress: This client's address which can be optionally used to determine the FSC 

assignments. 

• AssignedFSCURIs: Optional array of FSCs assigned to this client. These are passed in the 

form {"http://192.168.1.1:1234", "http://192.168.1.2:1234"}. These are configured in 

fmsmaster.xml as fscid and clientmap. 

• BootstrapFSCURIs: An array of bootstrap FSCs to get FSC assignments from. These are 

passed in the form {"http://192.168.1.1:1234", "http://192.168.1.2:1234"}. These are set as 

values for the preference FMS_Bootstrap_Urls and can be listed by running the command 

line utility backup_xmlinfo. 

This initialization can be a direct assignment of assigned FSCs URIs, or via a bootstrap procedure 

that queries the FMS system to find assigned FSCs based on the supplied client IP. Direct 

initialization is invoked by passing assignedFSCURIs. The FMS system is not queried for assigned 
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FSCs. Bootstrap initialization is invoked by passing bootstrapFSCURIs and clientIPAddress. The 

bootstrap FSCs will be queried to get assigned FSCs for the given client IP. If the client IP is null or 

an empty string, the bootstrap servers will use the client address off the connection. Assigned FSCs 

are kept in the proxy and used by default on all other APIs. Optionally, specific FSCs to be used for 

a given API call by passing them in fscServerURIs. 

3.3.2.3.5 Other Teamcenter settings 

<WorkingGroup>V6Group</WorkingGroup> 

Name of TCI working group in Teamcenter. Item Revisions owned by 3DEXPERIENCE will be 

moved to this group. 

 

<MinimizeLoadProperties enabled="true" /> 

Set enabled to “true” to aggressively minimize loadProperties calls. 

Default setting is “false”. 

 

<ReportDatasetType>Text</ReportDatasetType> 

<ReportDatasetNamedRef>Text</ReportDatasetNamedRef> 

Defines the dataset type to be used for the report functionality. 

Default settings are “Text” each. 

 

<ExportDatasetType>Text</ExportDatasetType> 

<ExportDatasetNamedRef>Text</ExportDatasetNamedRef> 

Defines the dataset type to be used for the export functionality. 

Default settings are “Text” each. 

 

The Teamcenter policy can be loaded by Server policy or a local file path. 

<PolicyPath>TCI_Policy</PolicyPath> 

Optional definition of the Teamcenter server policy to load. 

<PolicyLocalPath>C:\TCI\TCI_PolicyFile.xml</PolicyLocalPath> 

Optional local file definition for the Teamcenter policy to load. 

<LatestRevisionRuleUid>da12b3d4ef54gt</LatestRevisionRuleUid> 

The revision rule uid used to get the latest Revision. 

 

3.3.2.3.6 TcIC compatibility 

To support as most as possible environments TCI can be configured to run in TcIC compatibility 

mode. This will modify the default behavior to match some specialties of the environment. 

To switch on the TcIC compatibility mode the following configurations must be set in the TCI 

configuration file in the Teamcenter section. 

<Teamcenter> 

 … 
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 <TcICCompatibility enabled="true"/> 

 … 

</Teamcenter> 

Additionally, the following optional settings can be set: 

▪ OccurrenceProperty: default is “bl_occurrence_name” 

▪ OccurrenceNote: default is “catiaOccurrenceName” 

▪ BomLineOccurrenceProperty: default is “catiaOccurrenceName” 

▪ BomViewRevisionType: default is “catia” 

3.3.2.3.7 CMI RII compatibility 

To support as most as possible environments TCI can be configured to run in CMI RII compatibility 

mode. This will modify the default behavior to match some specialties of the environment. 

To switch on the CMI RII compatibility mode the following configurations must be set in the TCI 

configuration file in the Teamcenter section. 

<Teamcenter> 

 … 

 < CMIRIICompatibility enabled="true"/> 

 … 

</Teamcenter> 

Additionally, the following optional settings can be set: 

▪ HandleAuxForms: true to handle aux files for CMI RII, default is true 

3.3.2.3.8 ConfigurationImport 

Teamcenter Configuration Import settings. 

<ConfigurationImport> 
 <ConfigurationCreateItemType>Item</ConfigurationCreateItemType>
 <RemoveExistingOptionValues>false</RemoveExistingOptionValues> 
           < VariantRuleType>VariantRule</VariantRuleType> 
 <VariantRuleRelationType>IMAN_specification</VariantRuleRelationType> 
 <RevisionRuleForVariants>rev-rule-uid</RevisionRuleForVariants> 
 <RemoveOldVariantRule>true</RemoveOldVariantRule> 
 <DeleteOldVariantRule>false</DeleteOldVariantRule> 
 <SkipRemoveUnneedeBrackets>false</RemoveExistingOptionValues> 
 <OccurrenceEffectivityStartDateINF>1970-01-01</OccurrenceEffectivityStartDateINF> 
 <OccurrenceEffectivityTimeZone>MET</OccurrenceEffectivityTimeZone> 
       <ProductConfiguratorNamespace>3DEXPERIENCE</ProductConfiguratorNamespace> 
</ConfigurationImport> 

Settings for the Option and Variant Rule import. 

ConfigurationCreateItemType: the Item type to use for the creation of new Item configuration objects. 

Default is “Item” 

RemoveExistingOptionValues: true to remove existion option values, default is false. 

VariantRuleType: Variant Rule Type (VariantRule) to use when importing 3DX Variant Rules in 

Teamcenter, default is VariantRule. It must be set same as in Teamcenter Preference 

Cfg0CreateVariantRuleType. 
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VariantRuleRelationType: the variant rule relation type, default is IMAN_specification. 

RevisionRuleForVariants: the Revision rule uid to use for option update.  

RemoveOldVariantRule: true to remove old variant rules from the configuration object, default is true. 

DeleteOldVariantRule: true to delete old variant rules, default is false. 

SkipRemoveUnneedeBrackets: true to skip the removeUnneedeBrackets functionality, default is 

false 

Settings for the Date Effectivity import: 

OccurrenceEffectivityStartDateINF: the start date for INF values from 3DEXPERIENCE, default is 

1970-01-01. 

OccurrenceEffectivityTimeZone: the ID for a TimeZone, either an abbreviation such as "PST", a full 

name such as "America/Los_Angeles", or a customID such as "GMT-8:00". 

ProductConfiguratorNamespace: namespace when importing Families in Product Configurator data 

model. Default is 3DEXPERIENCE.  
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3.3.2.4 Enovia 

In the following chapters the configuration options for the tag Enovia are described. 

3.3.2.4.1 3DEXPERIENCE Server definition 

The 3DEXPERIENCE connection is defined in the Server section. 

<Server> 
 <Url>https://enovia-server.url:port/3dspace</Url> 
 <Username>user</Username> 
 <Password>XXX</Password> 
 <Role>ctx::VPLMAdmin.Company Name.Default</Role> 
 <Vault>vplm</Vault> 
 <Use3DPassport>true</Use3DPassport> 
</Server> 

Definition of the 3DEXPERIENCE server URL and the login credentials of the TCI user. 

The Username and the Password belong to an existing 3DEXPERIENCE user. You can also specify 

the Role and the Vault. Set Use3DPassport, if the login uses the 3DPassport service. 

The encryption of the password is described in section Server Password in chapter 3.3.2.3.2. 

3.3.2.4.2 3DEXPERIENCE TDXServer definition 

The 3DEXPERIENCE Rest connection is defined in the TDXServer section. 

<TDXServer> 

 <ExchangeUrl></ExchangeUrl> 

 <SpaceUrl>url to the 3dspace</SpaceUrl> 

 <PassportUrl>url to the 3dpassport</PassportUrl> 

 <Username>username</Username> 

 <Password>encrypted password</Password> 

 <SecurityContext>VPLMProjectLeader.Company Name.Common 

Space</SecurityContext> 

 <Tenant>OnPremise</Tenant> 

 <Language>en</Language> 

 <SessionTimout enabled="true">30</SessionTimout> 

</TDXServer> 

Definition of the 3DEXPERIENCE server for the Rest API. 

The Username and the Password belong to an existing 3DEXPERIENCE user. 

The encryption of the password is described in section Server Password in chapter 3.3.2.3.2. 

The SecurityContext defines the security context to use. 

The Tenant defines the tenant. 

The Language defines the ISO code of the language, default is “en”, used to get translated messages 

from 3DEXPERIENCE. 

The SessionTimout defines the session timeout of the 3DEXPERIENCE session, used to renew the 

session if enabled. 

3.3.2.4.3 General 3DEXPERIENCE settings 

<FileCache enabled="true"> 
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 <XciFcUrl>http://my.tci-integration-server.url:port/XCI_FC</XciFcUrl> 
</FileCache> 

Is only used if the TDXExportMode is set to “ExportFiles”. 

Defines the File Cache URL used to cache files for the export files mode. 

Default setting is “false”. 

 

<SessionTimeout enabled="true">30</SessionTimeout> 

Defines the timeframe of inactivity in the 3DEXPERIENCE session before a relogin is done in the 

next operation in the session. 

Default setting is “30” minutes. 

 

<MappingContextName>XPDM<MappingContextName> 

The mapping context name to use, used to find the correct mapping in 3DEXPERIENCE. 

 

<ReceiveInterval>4000</ReceiveInterval> 

Optional definition in which interval the events should be received in milliseconds (ms). 

Default setting is “5000” (5 seconds). 

 

<SchemaPath>...\resources\xsd\XPG\XPDMXML.xsd</SchemaPath> 

Definition of the schema to be used to validate XPDM messages. If the file path is not defined or 

incorrect, the incoming and outgoing XPDMXML files will not be validated but processed. 

 

<Customization>DefaultCustomization</Customization> 

Definition of the customization to use in XPDM events. This customization must be defined in the 

pdm-cust-config.xml in the 3DEXPERIENCE installation. 

The com.tsystems.xci.customization.CustomTypeMapping customization class can 

overwrite this setting. 

 

<GetMetadataSettings> 
<ProductObject enoviaType="VPMReference"> 
 <AttributeName display="Type">type</AttributeName> 
 <AttributeName display="Name">name</AttributeName> 
 <AttributeName display="Revision">revision</AttributeName> 
 <AttributeName display="Vault">vault</AttributeName> 
 <AttributeName display="Policy">policy</AttributeName> 
 <AttributeName display="State">current</AttributeName> 
 <AttributeName display="Created">originated</AttributeName> 
 <AttributeName display="Modified">modified</AttributeName> 
 <AttributeName display="Owner">owner</AttributeName> 
 <AttributeName display="Organization">organization</AttributeName> 
 <AttributeName display="Project">project</AttributeName> 
 <AttributeName display="External 
ID">attribute[PLMEntity.PLM_ExternalID]</AttributeName> 
 <AttributeName display="Title">attribute[PLMEntity.V_Name]</AttributeName> 
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 <AttributeName display="">attribute[PLMEntity.V_description]</AttributeName> 
</ProductObject> 

</GetMetadataSettings> 

GetMetadataSettings defines the attributes which are returned from the “Show 3DEXPERIENCE 

Properties” command in the TCI Teamcenter Rich Client. 

 
<EnableNonCatiaExpand>false</EnableNonCatiaExpand> 

Is only relevant if the TDXExportMode is set to “ExportFiles”. 

If set to “true” all geometries are exported, else only 3DPart geometries are exported. 

Default setting is “false”. 

 
<VPMReferenceDisplayPattern>{attribute[PLMEntity.PLM_ExternalID]} 
{majorrevision}</VPMReferenceDisplayPattern> 

Display pattern for VPMReferences (Physical Products). 

Default setting is “{attribute[PLMEntity.PLM_ExternalID]} {revision} 

{attribute[PLMEntity.V_Name]}”. 

 
<DocumentDisplayPattern>{name} {revision}</VPMReferenceDisplayPattern> 

Display pattern for documents. 

Default setting is “{name} {revision}”. 

 
<FolderDisplayPattern>{attribute[PLMEntity.PLM_ExternalID]}</FolderDisplayPattern> 

Display pattern for Folder. 

Default setting is “{attribute[PLMEntity.PLM_ExternalID]}”. 

 
<RootFolderDisplayPattern>{attribute[PLMEntity.PLM_ExternalID]}</RootFolderDisplayPattern> 

Display pattern for Root Folder. 

Default setting is “{attribute[PLMEntity.PLM_ExternalID]}”. 

 
<FolderConnectionDisplayPattern>{attribute[PLMEntity.PLM_ExternalID]}</FolderConnectionDispl
ayPattern> 

Display pattern for FolderConnections. 

Default setting is “{attribute[PLMEntity.PLM_ExternalID]}”. 

 

<BookmarkDisplayPattern>{name}</ BookmarkDisplayPattern> 

Display pattern for Bookmark. 

Default setting is “{name}”. 

 

<RootBookmarkDisplayPattern>{name}</RootBookmarkDisplayPattern> 

Display pattern for Root Bookmark. 

Default setting is “{name}”. 
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<ConfigurationModelDisplayPattern>{name} {attribute[Marketing Name]}</ 
ConfigurationModelDisplayPattern> 

Display pattern for Configuration Model. 

Default setting is “{name} {attribute[Marketing Name]}”. 

 

<ConfigurationModelVersionDisplayPattern>{name} {attribute[Marketing Name]} {revision}</ 
ConfigurationModelVersionDisplayPattern> 

Display pattern for Configuration Model Version. 

Default setting is “{name} {attribute[Marketing Name]} {revision}”. 

 

<ChildObjectExpandPattern>VPMReference</ChildObjectExpandPattern> 

Optional expand pattern for child part objects. Comma separated list of types. 

Default setting is “VPMReference”. 

 

<ChildRelationExpandPattern>VPMInstance</ChildRelationExpandPattern> 

Optional expand pattern for child relations. Comma separated list of relation types. 

Default setting is “VPMInstance”. 

 

<RepObjectExpandPattern>VPMRepReference</RepObjectExpandPattern> 

Optional expand pattern for representation objects. Comma separated list of types. 

Default setting is “VPMRepReference”. 

 

<RepRelationExpandPattern>VPMRepInstance</RepRelationExpandPattern> 

Optional expand pattern for representation relations. Comma separated list of relation types. 

Default setting is “VPMRepInstance”. 

 

<CatiaV5ExportVersion>V5R28</CatiaV5ExportVersion> 

The CATIA V5 version used to store the info in Teamcenter. 

 

<ImportPowerBy enabled="true" /> 

Enable to activate 3DEXPERIENCE import in POWER'BY mode. Data will be imported in native V5 

format into 3DEXPERIENCE and can then be loaded using the Dassault POWER'BY Integration of 

3DEXPERIENCE and V5. 

Default is false, i.e. data will be imported in V6 mode. 

 

<ExportWithStateFilter enabled="true">FROZEN,RELEASED</ExportWithStateFilter> 

If enabled only objects with the configured state are exported from 3DEXPERIENCE. The value is a 

comma separated list of allowed states. 

<RemoveNon3DPartRep3D>false</RemoveNon3DPartRep3D> 
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True to remove Rep3D/Rep3DInst and Rep3DAggr from the xpdm export which are not connected 

with a 3DPart. 

<UseBookmark>true</UseBookmark> 

True to use Bookmark class for Folder functionality. Default is false. 

<UseBookmarkRestApi>true</UseBookmarkRestApi> 

True to use the Bookmark Rest APi for bookmark import (UseBookmark must be true). Default is 

false. 

<EnableEnoauthoringApi>true</EnableEnoauthoringApi> 

True to use the enoauthoring Api. Default is true. 

<HoldConnectionOpenInSeconds>60</HoldConnectionOpenInSeconds> 

Seconds to keep the 3DEXPERIENCE service connection open while waiting for new service 

connection request. The default value is 60. 

<RestApiUseOneSearchField>true</RestApiUseOneSearchField> 

True to use only one untyped search field for the 3DEXP search in the web client. 

<BulkOperation> 

 <VPMReferenceQueryParallelSize>1</VPMReferenceQueryParallelSize> 

</ BulkOperation > 

Specific operations can be parallelized by running multiple threads. Define how many threads can 

be started in parallel for: 

• VPMReferenceQueryParallelSize: query for VPMReference objects. Default is 1 because 

ADK seems to serialize the queries and there would be a performance loss due to overhead. 

For REST / Cloud this should be set to a higher value (e.g. 20). 

 

3.3.2.4.4 3DEXPERIENCE Rest meta definition 

The EnoviaRestMeta setting is used to overwrite defaults used by the 3DEXPERIENCE rest api and 

to describe the 3DEXPERIENCE datamodel. 

<EnoviaRestMeta> 

 <MetaObject superName="VPMReference">NewType1,NewType2</MetaObject> 

 <CadOriginExtensionMapping cadOrigin="CATIAV5">CATProduct</CadOriginExtensionMapping> 

… 

</EnoviaRestMeta> 

MetaObject: define Supertype - SubtypeList (comma separated list). 

CadOriginExtensionMapping: mapping from cad origin to assembly file extension. 

DocTypeExtensionMapping: mapping from document type to assembly file extension. 

TDDocumentRepresentationTypes: Document Representation types separated by comma. Default is 

Document. 

TDDocumentRepRelation: Relation name for Document Representation types. Default is 

PLMDocConnection. 

TDXCADProductRepresentationTypes: Document Representation types separated by comma. Default 

is XCADAssemblyRepReference. 
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TDXCADProductRepRelation: Relation name for Document Representation types. Default is 

XCADAssemblyRepInstance. 

 

3.3.2.4.5 SecurityContext translation definition 

The Teamcenter client provides a 3DEXPERIENCE login enhancement to select a security context 

in 3DEXPERIENCE based on Role, Organization, and Collaborative space. The display values for 

Role, Organization and CollaborativeSpace can be configured. 

<SecurityContextTranslation> 

 <Role name="VPLMAdmin" display="Administrator"/> 

 <Role name="VPLMCreator" display="Author"/> 

 <Role name="VPLMExperimenter" display="Contributor"/> 

 <Role name="VPLMProjectAdministrator" display="Owner"/> 

 <Role name="VPLMProjectLeader" display="Leader"/> 

 <Role name="VPLMViewer" display="Reader"/> 

 <Role name="VPLMSecuredCrossAccess" display="Public Reader"/> 

 <Role name="VPLMAdmin" display="Administrator"/> 

</SecurityContextTranslation> 

 

3.3.2.4.6 3DEXPERIENCE Query definition 

The TCI integration inside Teamcenter provides an online query in 3DEXPERIENCE without 

changing the application. Based on the query result a data transfer from 3DEXPERIENCE to 

Teamcenter can be initiated. For the configuration of the data transfer please refer to chapter 

3.3.2.4.7. 

The corresponding configurations for the query in 3DEXPERIENCE are defined in the QuerySettings 

section. 

<QuerySettings> 
 <DefaultEnoviaRole>VPLMCreator</DefaultEnoviaRole> 
 <DefaultEnoviaVault>vplm</DefaultEnoviaVault> 
 <QueryLimit>200</QueryLimit> 
 <QueryTypes> 
     <QueryType display="Physical Product">VPMReference</QueryType> 
 </QueryTypes> 
 <QueryAttributes> 
     <QueryAttribute display="Identification code" visible="true">id</QueryAttribute> 
     <QueryAttribute display="Type" visible="true">type</QueryAttribute> 
     <QueryAttribute display="Name" visible="true">name</QueryAttribute> 
     <QueryAttribute display="Revision" visible="true">revision</QueryAttribute> 
     <QueryAttribute display="Vault" visible="true">vault</QueryAttribute> 
     <QueryAttribute display="Policy" visible="true">policy</QueryAttribute> 
     <QueryAttribute display="Current State" visible="true">current</QueryAttribute> 
     <QueryAttribute display="Originated" visible="true">originated</QueryAttribute> 
     <QueryAttribute display="Modified" visible="true">modified</QueryAttribute> 
     <QueryAttribute display="Owner" visible="true">owner</QueryAttribute> 
     <QueryAttribute display="Organization" visible="true">organization</QueryAttribute> 
     <QueryAttribute display="Project" visible="true">project</QueryAttribute> 
     <QueryAttribute display="Major Revision" visible="true">majorrevision</QueryAttribute> 
     <QueryAttribute display="Minor Revision" visible="true">minorrevision</QueryAttribute> 
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     <QueryAttribute display="ExternalID" visible="true"> 
attribute[PLMEntity.PLM_ExternalID]</QueryAttribute> 

     <QueryAttribute display="V_Name" visible="true"> 
     attribute[PLMEntity.V_Name]</QueryAttribute> 
     <QueryAttribute display="V_description" visible="true"> 
     attribute[PLMEntity.V_description]</QueryAttribute> 
 </QueryAttributes> 
</QuerySettings> 

 

DefaultEnoviaRole and the DefaultEnoviaVault are used as defaults for the 3DEXPERIENCE login. 

The configured values are presented in the 3DEXPERIENCE login dialog window and can be 

modified by the user. If no default values are configured, empty input fields are presented to the 

user. 

QueryLimit defines the maximum number of query results presented to the user. If more matching 

objects are available in 3DEXPERIENCE, an information message will appear inside the user 

interface.  

The default setting is “100”. 

QueryTypes defines a list of selectable object types for the 3DEXPERIENCE query. Each 

QueryType defines one 3DEXPERIENCE object type (3DEXPERIENCE internal type name). The 

display attribute defines the type name presented to the user. If no query type is configured, an 

empty input field is presented to the user. In this case, the user has to input the 3DEXPERIENCE 

internal type name, like “VPMReference”. 

QueryAttributes defines the 3DEXPERIENCE attributes, which will be presented in the result table. 

The order of the attributes in the result table is also defined here and corresponds to the attribute 

sequence. Each QueryAttribute defines one 3DEXPERIENCE attribute, e.g. “majorrevision”. The 

display attribute defines a corresponding name used in the results window, e.g. “Major Revision”. If 

the visible attribute is set to “false”, the 3DEXPERIENCE attribute will not be visible inside the result 

window. The default for the visible attribute is “true”. If no query attributes are configured, a list of 

default attributes is used. 

Each line in the result window represents one 3DEXPERIENCE object. The user can select each 

line and initiate the data transfer from 3DEXPERIENCE to Teamcenter. To perform the transfer, the 

configured TDXExportMode will be used. See chapter 3.3.2.1.28 for detailed information. 

3.3.2.4.7 TSI3DXBatch Definitions 

The following tags are used in TSI3DXBatch definitions below: 

▪ CatStartPath defines the path to the batch tool CATSTART.exe. 

▪ CatStartDirEnv defines the directory, where the CATSTART environment is located. 

▪ CatStartEnv defines the CATSTART environment. 

▪ ServerUrl defines the 3DEXPERIENCE server URL. 

o It is mandatory to include the port in the URL. :443 for https and :80 for http or your 

custom port. 

▪ Environment defines the 3DEXPERIENCE environment. 

▪ Username defines the 3DEXPERIENCE username, used to initiate the data transfer. 

▪ Password defines the 3DEXPERIENCE user password for the 3DEXPERIENCE user.  

o In a CAS environment, a permanent Login Ticket is required. 

▪ FileFormat2D defines the 2D export file format. 
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▪ FileFormat3D defines the 3D export file format. 

▪ GeometryType3D defines the 3D type of geometry. 

o “Exact” transfers the authoring data (exact geometry) 

o “Tesselated” transfers the visualization data 

o “AsSpecifications” exports all 3D Shapes with their specifications  

▪ SecurityCtx defines the 3DEXPERIENCE security context (Role.Organization.Project). 

▪ SiteId defines PLM Mapping Context for the target site. 

▪ WithFiles used for XPDMExport: 

o Yes (default): Export files with XPDMExport. 

o No: do not export files with the XPDMExport (use FileExportConfiguration). 

o IfModified: only export Modified Files. (Missing files are exported based on the 

FileExportConfiguration) 

▪ WithDocuments used for XPDMExport: 

o Yes (default): Export non cad documents with XPDMExport. 

o No: do not export non cad documents with the XPDMExport. 

▪ WithPLMParams used for XPDMExport: 

o Yes (default): Export PLM Parameter with XPDMExport. 

o No: do not export PLMParameter with the XPDMExport. 

▪ MappingInfoResult used for mapping info export: 

o All (default): Export mapping info result to one file. 

o Each: one result file for each mapping info entry in the input file. 

▪ MappingInfoExposed used for mapping info export. 

o TRUE (default): export only exposed mapping. 

o FALSE: export exposed and internal mapping. 

The following attributes are used for the processing definitions: 

▪ usecs: Set to “true” to use the Converter Server. 

▪ tdsUrl: TCI directory service URL (http://my.tci-integration-server.url:port/XCI/XCI_TDS). 

▪ csTimeout: Converter Server timeout in seconds used to wait for free Converter Server host. 

Default setting is “0” (no timeout). 

▪ resource: Name of the resource (see chapter 3.3.2.1.39). 

The following tags are used in the Host definition: 

▪ Url: The URL to the processing application. 

▪ Command: The command used on the processing host (see Url). 

Optional tags are: 

▪ Timeout: The timeout in seconds. Default setting is “0” (no timeout). 

▪ MaxParallel: The maximum number of parallel conversions running on the host. 

▪ TaskkillCommand: The task kill command used to stop the running command after the 

waiting time (Timeout) elapses. Default taskkill /F /PID ___PID___ where ___PID___ 

will be replaced by the process id at execution time. 

▪ DisableTaskkill: Set to true to disable forceful termination of the command when timeout is 

reached. Default: false. 

The following attributes are used for the host definitions: 

▪ local: Set to “true” will skip the file transfer via Converter Server and directly work in the 

persistent directory (must be accessible from the hosts). Default setting is “false”. 
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▪ cleanupWorkdir: Set to “true” will clean the Converter Server work directory after result files 

have been transferred to TCI. Default setting is “true”. 

The TDXExportMode defines the 3DEXPERIENCE export mode; the TDXImportMode defines the 

3DEXPERIENCE import mode. 

In the following sections export and import definitions are described. 

Optional attributes for the definitions without Converter Server settings are: 

▪ timeout: The timeout in seconds. Default setting is “0” (no timeout). 

▪ taskkillCommand: The task kill command used to stop the running command after the waiting 

time (Timeout) elapses. Default taskkill /F /PID ___PID___ where ___PID___ will be 

replaced by the process id at execution time. 

▪ disableTaskkill: Set to true to disable forceful termination of the command when timeout is 

reached. Default: false. 

 

3.3.2.4.7.1 SetFilter definition 

Set Filter in 3DEXPERIENCE using the 3DEXPERIENCE Batch utility. 

<SetFilter> 
 <CatStartPath>C:\enoviaV6R2018x\B420\win_b64\code\bin\CATSTART.exe</CatStartPath> 
 <CatStartEnv>TSI_3DX_EXP_Env</CatStartEnv> 
 <CatStartDirEnv>C:\TCI\TSI_3DX_EXP_R2018x\config</CatStartDirEnv> 
 <ServerUrl>https://enovia-server.url:port/3dspace</ServerUrl> 
 <Environment>UnifiedTyping</Environment> 
 <Username>LoginTicket</Username> 
 <Password>XXX</Password> 
</Cloc > 

Set Filter without the Converter Server. 

The configurations are defined in the TSI3DXBatch Definitions section. 

 

<SetFilterProcessingusecs="true" tdsUrl="http://my.tci-integration-server.url:port/XCI/XCI_TDS"> 
 <SetFilterHostlocal="false"> 
  <Url>http://my.tci-integration-server.url:port/XCI_CS</Url> 
  <Command>XPDMExportCommand</Command> 
 </SetFilterHost> 
 <SetFilterCommandcommandName="XPDMExportCommand"> 
  <CatStartPath>C:\enoviaV6R2018x\B420\win_b64\code\bin\CATSTART.exe</CatStartPath> 
  <CatStartEnv>TSI_3DX_EXP_Env</CatStartEnv> 
  <CatStartDirEnv>C:\TCI\TSI_3DX_EXP_R2018x\config</CatStartDirEnv> 
  <ServerUrl>https://enovia-server.url:port/3dspace</ServerUrl> 
  <Environment>UnifiedTyping</Environment> 
  <Username>LoginTicket</Username> 
  <Password>XXX</Password> 
 </SetFilterCommand> 
</SetFilterProcessing> 

Set Filter with the use of the Converter Server. 

The configurations are defined in the TSI3DXBatch Definitions section. 

3.3.2.4.7.2 ClocProcessing definition 

Process CLOC in 3DEXPERIENCE using the 3DEXPERIENCE Batch utility. 
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<Cloc > 
 <CatStartPath>C:\enoviaV6R2018x\B420\win_b64\code\bin\CATSTART.exe</CatStartPath> 
 <CatStartEnv>TSI_3DX_EXP_Env</CatStartEnv> 
 <CatStartDirEnv>C:\TCI\TSI_3DX_EXP_R2018x\config</CatStartDirEnv> 
 <ServerUrl>https://enovia-server.url:port/3dspace</ServerUrl> 
 <Environment>UnifiedTyping</Environment> 
 <Username>LoginTicket</Username> 
 <Password>XXX</Password> 
 <ContextName>XPDM</ContextName> 
</Cloc > 

Process CLOC without the Converter Server. 

The configurations are defined in the TSI3DXBatch Definitions section. 

 

<ClocProcessing usecs="true" tdsUrl="http://my.tci-integration-server.url:port/XCI/XCI_TDS"> 
 <ClocHost local="false"> 
  <Url>http://my.tci-integration-server.url:port/XCI_CS</Url> 
  <Command>XPDMExportCommand</Command> 
 </ClocHost > 
 <ClocCommand commandName="XPDMExportCommand"> 
  <CatStartPath>C:\enoviaV6R2018x\B420\win_b64\code\bin\CATSTART.exe</CatStartPath> 
  <CatStartEnv>TSI_3DX_EXP_Env</CatStartEnv> 
  <CatStartDirEnv>C:\TCI\TSI_3DX_EXP_R2018x\config</CatStartDirEnv> 
  <ServerUrl>https://enovia-server.url:port/3dspace</ServerUrl> 
  <Environment>UnifiedTyping</Environment> 
  <Username>LoginTicket</Username> 
  <Password>XXX</Password> 
  <ContextName>XPDM</ContextName> 
 </ClocCommand > 
</ClocProcessing > 

Process CLOC with the use of the Converter Server. 

The configurations are defined in the TSI3DXBatch Definitions section. 

3.3.2.4.7.3 MappingInfo definition 

Retrieve Mapping information from 3DEXPERIENCE using the 3DEXPERIENCE Batch utility. 

<MappingInfo> 
 <CatStartPath>C:\enoviaV6R2018x\B420\win_b64\code\bin\CATSTART.exe</CatStartPath> 
 <CatStartEnv>TSI_3DX_EXP_Env</CatStartEnv> 
 <CatStartDirEnv>C:\TCI\TSI_3DX_EXP_R2018x\config</CatStartDirEnv> 
 <ServerUrl>https://enovia-server.url:port/3dspace</ServerUrl> 
 <Environment>UnifiedTyping</Environment> 
 <Username>LoginTicket</Username> 
 <Password>XXX</Password> 
 <ContextName>XPDM</ContextName> 
</MappingInfo > 

Retrieve Mapping information without the Converter Server. 

The configurations are defined in the TSI3DXBatch Definitions section. 

 

<MappingInfoProcessing usecs="true" tdsUrl="http://my.tci-integration-
server.url:port/XCI/XCI_TDS"> 
 <MappingInfoHost local="false"> 
  <Url>http://my.tci-integration-server.url:port/XCI_CS</Url> 
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  <Command>XPDMExportCommand</Command> 
 </MappingInfoHost > 
 <MappingInfoCommand commandName="XPDMExportCommand"> 
  <CatStartPath>C:\enoviaV6R2018x\B420\win_b64\code\bin\CATSTART.exe</CatStartPath> 
  <CatStartEnv>TSI_3DX_EXP_Env</CatStartEnv> 
  <CatStartDirEnv>C:\TCI\TSI_3DX_EXP_R2018x\config</CatStartDirEnv> 
  <ServerUrl>https://enovia-server.url:port/3dspace</ServerUrl> 
  <Environment>UnifiedTyping</Environment> 
  <Username>LoginTicket</Username> 
  <Password>XXX</Password> 
  <ContextName>XPDM</ContextName> 
 </MappingInfoCommand > 
</MappingInfoProcessing > 

Retrieve Mapping information with the use of the Converter Server. 

The configurations are defined in the TSI3DXBatch Definitions section. 

3.3.2.4.7.4 XPDM Export definition 

Direct export of a structure from 3DEXPERIENCE using the XPGClientBatch utility. 

<XPDMExport> 
 <CatStartPath>C:\enoviaV6R2018x\B420\win_b64\code\bin\CATSTART.exe</CatStartPath> 
 <CatStartEnv>TSI_3DX_EXP_Env</CatStartEnv> 
 <CatStartDirEnv>C:\TCI\TSI_3DX_EXP_R2018x\config</CatStartDirEnv> 
 <ServerUrl>https://enovia-server.url:port/3dspace</ServerUrl> 
 <Environment>UnifiedTyping</Environment> 
 <Username>LoginTicket</Username> 
 <Password>XXX</Password> 
 <FileFormat3D>CATIAV5-6R2018</FileFormat3D> 
 <GeometryType3D>AsSpecifications</GeometryType3D> 
 <FileFormat2D>CATIAV5-6R2018</FileFormat2D> 
 <SiteId>XPDM</SiteId> 
 <WithFiles>No</WithFiles> 
</XPDMExport> 

Export without the Converter Server. 

The configurations are defined in the TSI3DXBatch Definitions section. 

 

<XPDMExportProcessing usecs="true" tdsUrl="http://my.tci-integration-
server.url:port/XCI/XCI_TDS"> 
 <XPDMExportHost local="false"> 
  <Url>http://my.tci-integration-server.url:port/XCI_CS</Url> 
  <Command>XPDMExportCommand</Command> 
 </XPDMExportHost> 
 <XPDMExportCommand commandName="XPDMExportCommand"> 
  <CatStartPath>C:\enoviaV6R2018x\B420\win_b64\code\bin\CATSTART.exe</CatStartPath> 
  <CatStartEnv>TSI_3DX_EXP_Env</CatStartEnv> 
  <CatStartDirEnv>C:\TCI\TSI_3DX_EXP_R2018x\config</CatStartDirEnv> 
  <ServerUrl>https://enovia-server.url:port/3dspace</ServerUrl> 
  <Environment>UnifiedTyping</Environment> 
  <Username>LoginTicket</Username> 
  <Password>XXX</Password> 
  <FileFormat3D>CATIAV5-6R2018</FileFormat3D> 
  <GeometryType3D>AsSpecifications</GeometryType3D> 
  <FileFormat2D>CATIAV5-6R2018</FileFormat2D> 
  <SiteId>XPDM</SiteId> 
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  <WithFiles>No</WithFiles> 
 </XPDMExportCommand> 
</XPDMExportProcessing> 

Export with the use of the Converter Server. 

The configurations are defined in the TSI3DXBatch Definitions section. 

3.3.2.4.7.5 XPDM Import definition 

Direct import of a structure to 3DEXPERIENCE using the XPGClientBatch utility. 

<XPDMImport> 
 <CatStartPath>C:\enoviaV6R2018x\B420\win_b64\code\bin\CATSTART.exe</CatStartPath> 
 <CatStartEnv>TSI_3DX_EXP_Env</CatStartEnv> 
 <CatStartDirEnv>C:\TCI\TSI_3DX_EXP_R2018x\config</CatStartDirEnv> 
 <ServerUrl>https://enovia-server.url:port/3dspace</ServerUrl> 
 <Environment>UnifiedTyping</Environment> 
 <Username>LoginTicket</Username> 
 <Password>XXX</Password> 
 <SiteId>XPDM</SiteId> 
</XPDMImport> 

Import without the Converter Server. 

The configurations are defined in the TSI3DXBatch Definitions section. 

 

<XPDMImportProcessing usecs="true" tdsUrl="http://my.tci-integration-
server.url:port/XCI/XCI_TDS"> 
 <XPDMImportHost local="false" cleanupWorkdir="false"> 
  <Url>http://my.tci-integration-server.url:port/XCI_CS</Url> 
  <Command>XPDMImportCommand</Command> 
 </XPDMImportHost> 
 <XPDMImportCommand commandName="XPDMImportCommand"> 
  <CatStartPath>C:\enoviaV6R2018x\B420\win_b64\code\bin\CATSTART.exe</CatStartPath> 
  <CatStartEnv>TSI_3DX_EXP_Env_XPP</CatStartEnv> 
  <CatStartDirEnv>C:\TCI\TSI_3DX_EXP_R2018x\config</CatStartDirEnv> 
  <ServerUrl>https://enovia-server.url:port/3dspace</ServerUrl> 
  <Environment>UnifiedTyping</Environment> 
  <Username>LoginTicket</Username> 
  <Password>XXX</Password> 
  <SiteId>XPDM</SiteId> 
 </XPDMImportCommand> 
</XPDMImportProcessing> 

Import with the use of the Converter Server. 

The configurations are defined in the TSI3DXBatch Definitions section. 

 

3.3.2.4.7.6 Folder Export definition 

Direct export of a root folder from 3DEXPERIENCE. 

<FolderExport> 
 <CatStartPath>C:\enoviaV6R2018x\B420\win_b64\code\bin\CATSTART.exe</CatStartPath> 
 <CatStartEnv>TSI_3DX_EXP_Env</CatStartEnv> 
 <CatStartDirEnv>C:\TCI\TSI_3DX_EXP_R2018x\config</CatStartDirEnv> 
 <ServerUrl>https://enovia-server.url:port/3dspace</ServerUrl> 
 <Environment>UnifiedTyping</Environment> 
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 <Username>LoginTicket</Username> 
 <Password>XXX</Password> 
 <SecurityCtx/> 
</FolderExport> 

Export without the Converter Server. 

The configurations are defined in the TSI3DXBatch Definitions section. 

 

<FolderExportProcessing usecs="true" tdsUrl="http://my.tci-integration-
server.url:port/XCI/XCI_TDS"> 
 <FolderExportHost local="false"> 
  <Url>http://my.tci-integration-server.url:port/XCI_CS</Url> 
  <Command>FolderExportCommand</Command> 
 </FolderExportHost> 
 <FolderExportCommand commandName="FolderExportCommand"> 
  <CatStartPath>C:\enoviaV6R2018x\B420\win_b64\code\bin\CATSTART.exe</CatStartPath> 
  <CatStartEnv>TSI_3DX_EXP_Env</CatStartEnv> 
  <CatStartDirEnv>C:\TCI\TSI_3DX_EXP_R2018x\config</CatStartDirEnv> 
  <ServerUrl>https://enovia-server.url:port/3dspace</ServerUrl> 
  <Environment>UnifiedTyping</Environment> 
  <Username>LoginTicket</Username> 
  <Password>XXX</Password> 
 </FolderExportCommand> 
</FolderExportProcessing> 

Export with the use of the Converter Server. 

The configurations are defined in the TSI3DXBatch Definitions section. 

3.3.2.4.7.7 Folder Import definition 

Direct import of a folder to 3DEXPERIENCE. 

<FolderImport> 
 <CatStartPath>C:\enoviaV6R2018x\B420\win_b64\code\bin\CATSTART.exe</CatStartPath> 
 <CatStartEnv>TSI_3DX_EXP_Env</CatStartEnv> 
 <CatStartDirEnv>C:\TCI\TSI_3DX_EXP_R2018x\config</CatStartDirEnv> 
 <ServerUrl>https://enovia-server.url:port/3dspace</ServerUrl> 
 <Environment>UnifiedTyping</Environment> 
 <Username>LoginTicket</Username> 
 <Password>XXX</Password> 
 <SecurityCtx/> 
</FolderImport> 

Import without the Converter Server. 

The configurations are defined in the TSI3DXBatch Definitions section. 

 
<FolderImportProcessing usecs="true" tdsUrl="http://my.tci-integration-
server.url:port/TCITCI_TDS"> 
 <FolderImportHost local="false"> 
  <Url>http://my.tci-integration-server.url:port/XCI_CS</Url> 
  <Command>FolderImportCommand</Command> 
 </FolderImportHost> 
 <FolderImportCommand commandName="FolderImportCommand"> 
  <CatStartPath>C:\enoviaV6R2018x\B420\win_b64\code\bin\CATSTART.exe</CatStartPath> 
  <CatStartEnv>TSI_3DX_EXP_Env</CatStartEnv> 
  <CatStartDirEnv>C:\TCI\TSI_3DX_EXP_R2018x\config</CatStartDirEnv> 
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  <ServerUrl>https://enovia-server.url:port/3dspace</ServerUrl> 
  <Environment>UnifiedTyping</Environment> 
  <Username>LoginTicket</Username> 
  <Password>XXX</Password> 
 </FolderImportCommand> 
</FolderImportProcessing> 

Import with the use of the Converter Server. 

The configurations are defined in the TSI3DXBatch Definitions section. 

3.3.2.4.7.8 File Export definition 

Direct export of a structure from 3DEXPERIENCE using the Downward Compatibility (DWC) utility. 

FileExport or FileExportProcessing define the 3DEXPERIENCE connection and batch specific 

settings. 

FileExportConfiguration defines which files to export (see section 3.3.2.4.7.8.1). 

Export without the Converter Server: 

<FileExport> 
 <CatStartPath>C:\enovia\B420\win_b64\code\bin\CATSTART.exe</CatStartPath> 
 <CatStartEnv>TSI_3DX_EXP_Env</CatStartEnv> 
 <CatStartDirEnv>C:\TCI\TSI_3DX_EXP_R2018x\config</CatStartDirEnv> 
 <ServerUrl>https://enovia-server.url:port/3dspace</ServerUrl> 
 <Environment>UnifiedTyping</Environment> 
 <Username>LoginTicket</Username> 
 <Password>XXX</Password> 
 <SecurityCtx/> 

< BatchInactivityTimeout>0</ BatchInactivityTimeout> 
 <DownwardCompatibility> 
  <Format> CATIAV5-6R2018</Format> 
  <GeometryType3D>AsSpecifications</GeometryType3D> 
 </DownwardCompatibilty> 
</FileExport> 

 

Export with the use of the Converter Server: 

<FileExportProcessing usecs="true" tdsUrl="http://my.tci-integration-server.url:port/XCI/XCI_TDS"> 
 <FileExportHost local="false"> 
  <Url>http://my.tci-integration-server.url:port/XCI_CS</Url> 
  <Command>Command2</Command> 
 </FileExportHost> 
 <FileExportCommand commandName="Command2"> 
  <CatStartPath>C:\enovia\B420\win_b64\code\bin\CATSTART.exe</CatStartPath> 
  <CatStartEnv>TSI_3DX_EXP_Env</CatStartEnv> 
  <CatStartDirEnv>C:\TCI\TSI_3DX_EXP_R2018x\config</CatStartDirEnv> 
  <ServerUrl>https://enovia-server.url:port/3dspace</ServerUrl> 
  <Environment>UnifiedTyping</Environment> 
  <Username>LoginTicket</Username> 
  <Password>XXX</Password> 
  <SecurityCtx/> 
  < BatchInactivityTimeout>0</ BatchInactivityTimeout> 
  <DownwardCompatibility> 
   <Format> CATIAV5-6R2018</Format> 
   <GeometryType3D>AsSpecifications</GeometryType3D> 
  </DownwardCompatibilty> 
 </FileExportCommand> 
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</FileExportProcessing> 
 
Use BatchInactivityTimeout to terminate DownwardCompatibility or DataExchangePLMBatch 
execution after inactivity. Default is 0 – no timeout. 
 

The examples show configurations for the DownwardCompatiblity batch. Other batches are defined 

similarly. 

• DownwardCompatiblity: 

o Format: target CATIA V5 format, must match CATIAVRxx for R18 – R21 or CATIAV5-

6Rxxx for 2012 or greater 

o GeometryType3D: export geometries with specification tree (AsSpecifications) or as 

solid body (Exact). Default: AsSpecifications. 

o TemplateCATPart: create CATParts based on a template CATPart. Must specify full 

path. 

o RetryGeometryExport: retry geometry export if export of a list of objects fails to isolate 

the failed object and export all other objects. Set to true or false. 

o JTV5: script to be executed after CATPart export to generate JT files. Must specify 

full path. 

o JT_ContinueOnError: continue exporting if JT generation fails. Set to true or false. 

o CreateJtForClass: create JTs only for these 3DEXPERIENCE object types. Separate 

multiple types with “,”. Types must be subtypes of PLMCoreRepReference. Default: 

3DShape. 

o CATFileFormatForJt: create JTs only for these file formats of exported files (e.g. 

CATPart). Separate multiple formats with “,”. Default: CATPart. 

• DataExchangePLMBatch: 

o MaxXCadBatchObjects: restrict maximum number of objects for a single 

DataExchangePLMBatch call. Default: 200. 

o XCadInvalidCharacters: replace invalid characters with “_” when constructing 

filenames for exported files. Default: \/:*?"<>| and tab character. 

• PLMPrintBatch: 

o PrintTemplate: full path to print template file. 

• Export3DXML: 

o RepresentationExport: export all representations (All), export 3DShapes (Yes) or 

export no representations (No). Default: Yes. 

o Format: export with (WithAuthoring) or without authoring information (ForReview). 

Default: WithAuthoring. 

o PropagateDepth: how many structure levels are included in the export: All, 1, 2, 3, … 

Default: All 

o CompatibilityMode: export 3DXML in compatibility mode: Yes or No. Default: Yes. 

o CompatibilityLevel: Specify compatibility level when exporting in compatibility mode: 

CompatibilityLevel2013x, CompatibilityLevel2020x. Only available from 2021x 

onwards. If defined, CompatibilityMode will be automatically set to YES. Default: 

none. 

3.3.2.4.7.8.1 File Export configuration 

The configuration for the FileExport (TDXExportMode is set to ExportFiles) can be configured with 

FileExportConfiguration settings. 

<FileExportConfiguration> 
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 <Source type="3DShape"> 
  <CATPart enableExport="false"/> 
  <Thumbnail enableExport="true" viewableSize="300">PNG</Thumbnail> 
  <XCAD enableExport="false" xCadFormat="wrl">VRML</XCAD> 
  <XCAD enableExport="false" >JT_COMFOX</XCAD> 
 </Source> 
 <Source type="VPMReference"> 
  <TDXML enableExport="false" /> 
  <CustomAttributes enableExport="true"> 
   <CustomAttribute xName="cusXname">attrName</CustomAttribute> 
  </CustomAttributes> 
 </Source> 
 <Source type="Drawing"> 
  <CATDrawing enableExport="false"/> 
  <Thumbnail enableExport="true" viewableSize="300">PNG</Thumbnail> 
  <Print enableExport="true"/> 
 </Source> 
 <RestApiExport enabled="true"> 
  <AssemblyExport enableExport="true" ignoreError="true"/> 
  <PartExport enableExport="true" ignoreError="false"/> 
  <DrawingExport enableExport="true" ignoreError="true"/> 
 </RestApiExport> 
</FileExportConfiguration> 

The FileExportConfiguration can be used to disable the CATPart or CATDrawing export. Also, 

Thumbnails or neutral formats can be exported. For detailed information about the configuration see 

the documentation of the Export batch in the “Readme_TSI3DXBatch.txt” file. 

For each source a set of custom attributes can be defined with the attribute name and the name in 

the XPDMXML file. 

The ignoreError flag can be set to true to ignore error at file export. 

The 3DXML export and the XCAD export can set the enableAssemblyCaching attribute to true to 

enable the Assembly file caching at export. 

The RestApiExport section defines exports with the Rest API from 3DEXPERIENCE. The 

TDXServer must be configured in the Enovia section.  

AssemblyExport: enableExport set to false will skip the assembly file (powerby) export. ignoreError 

set to true will continue on error. 

PartExport: enableExport set to false will skip the part file (powerby) export. ignoreError set to true 

will continue on error. 

DrawingExport: enableExport set to false will skip the drawing file (powerby) export. ignoreError set 

to true will continue on error. 

 

3.3.2.4.7.9 Revise in V6 configuration 

Trigger a revise in V6 from Teamcenter. Location of Control must be 3DEXPERIENCE. The object 

must have been transferred to 3DEXPERIENCE previously 

Direct revise without ConverterServer: 

<ReviseInV6> 
<CatStartPath>path-to\B419\win_b64\code\bin\CATSTART.exe</CatStartPath> 

 <CatStartEnv>TSI_3DX_EXP_XPP_XCI</CatStartEnv> 
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 <CatStartDirEnv>path-to-cat-env</CatStartDirEnv> 
 <ServerUrl>https://enovia-server-and-enovia-port/3dspace</ServerUrl> 
 <Environment>UnifiedTyping</Environment> 
 <Username>LoginTicket</Username> 
 <Password plaintext="true">XXX</Password> 
</ReviseInV6> 
 

Revise with ConverterServer: 

<ReviseInV6Processing usecs="true" tdsUrl="http://localhost:20180/XCI"> 
<ReviseInV6Host local="false"> 

  <Url>http://localhost:20182/XCI_CS</Url> 
  <Command>ReviseInV6Command</Command> 
 </ReviseInV6Host> 
 <ReviseInV6Command commandName="ReviseInV6Command"> 
  <CatStartPath> path-to\B419\win_b64\code\bin\CATSTART.exe</CatStartPath> 
  <CatStartEnv> TSI_3DX_EXP_XPP_XCI </CatStartEnv>    
  <CatStartDirEnv> path-to-cat-env </CatStartDirEnv> 
  <ServerUrl> https://enovia-server-and-enovia-port/3dspace /</ServerUrl> 
  <Environment>UnifiedTyping</Environment> 
  <Username>LoginTicket</Username> 
  <Password plaintext="true">XXX</Password> 
 </ReviseInV6Command> 
</ReviseInV6Processing> 

 

The configurations are defined in the TSI3DXBatch Definitions section. 

 

3.3.2.4.7.10 EffectivityExport configuration 

Export effectivities from 3DEXPERIENCE. 

Effectivity export without ConverterServer: 

<EffectivityExport> 
 <CatStartPath>path-to\B419\win_b64\code\bin\CATSTART.exe</CatStartPath> 
 <CatStartEnv>TSI_3DX_EXP_XPP_XCI</CatStartEnv> 
 <CatStartDirEnv>path-to-cat-env</CatStartDirEnv> 
 <ServerUrl>https://enovia-server-and-enovia-port/3dspace</ServerUrl> 
 <Environment>UnifiedTyping</Environment> 
 <Username>LoginTicket</Username> 
 <Password plaintext="true">XXX</Password> 
</EffectivityExport> 
 

Effectivity export with ConverterServer: 

<EffectivityExportProcessingusecs="true" tdsUrl="http://localhost:20180/XCI"> 
<EffectivityExportHostlocal="false"> 

  <Url>http://localhost:20182/XCI_CS</Url> 
  <Command>ExportEffectivitiesCommand</Command> 
 </EffectivityExportHost> 
 <EffectivityExportCommandcommandName="ExportEffectivitiesCommand"> 
  <CatStartPath> path-to\B419\win_b64\code\bin\CATSTART.exe</CatStartPath> 
  <CatStartEnv> TSI_3DX_EXP_XPP_XCI </CatStartEnv>    
  <CatStartDirEnv> path-to-cat-env </CatStartDirEnv> 
  <ServerUrl> https://enovia-server-and-enovia-port/3dspace /</ServerUrl> 
  <Environment>UnifiedTyping</Environment> 
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  <Username>LoginTicket</Username> 
  <Password plaintext="true">XXX</Password> 
 </EffectivityExportCommand> 
</EffectivityExportProcessing> 

 

The configurations are defined in the TSI3DXBatch Definitions section. 

 

3.3.2.4.8 Custom Attribute Mapping 

The CustomAttributeMapping in the Enovia section can be used to create a pdm-cust-config.xml file 

for xpdm import and export. 

<CustomAttributeMapping enabled="true" 
    createPdmCustConfigForExport="true" 
    createPdmCustConfigForImport="true"> 
 <CustomObject xname="Product" type="VPMReference" mappingtype="VPMReference"> 
  <CustomAttribute xname="V_versionComment" name="V_versionComment"  
    type="string" export="true" extensionname="MyExtension" /> 
 <CustomObject xname="Drawing" type="Drawing" mappingtype="Drawing"/> 
 <CustomObject xname="DrawingAggr" type="Drawing" mappingtype="Drawing"/> 
 <CustomObject xname="Rep3D" type="3DShape" mappingtype="3DShape"/> 
 <CustomObject xname="Rep3DAggr" type="3DShape" mappingtype="3DShape"/> 
 <CustomObject xname="Document" type="Document" mappingtype="Document"/> 
</CustomAttributeMapping> 

 

<CustomAttributeMapping> 

The mapping can be switched on or off using the enabled attribute. 

Set createPdmCustConfigForExport to true to create a pdm-cust-config.xml file for xpdm export. 

set createPdmCustConfigForImport to true to create a pdm-cust-config.xml file for xpdm import. 

It can contain multiple CustomObject definitions. 

<CustomObject> 

Each object definition has an xname, type, and mappingtype attribute and can contain multiple 

CustomAttribute definitions. 

<CustomAttribute> 

The xname defines the Property name in the XpdmXml. The type defines the data type of the 

property. The name is the 3DEXPERIENCE attribute name. The export and import flag define the 

attribute for import and/or export. The optional attribute extensionname must be set if this attribute 

belongs to an extension in 3DEXPERIENCE. 

Optional attribute unitConversionImport can be set to convert the attribute value to a different unit 

on 3DEXPERIENCE import. Set attribute to name of a conversion as defined in 

UnitConversionDefinition (see section 3.3.2.1.52). 

Optional attribute xpdmExposed can be set to false to export attributes from 3DEXPERIENCE that 

are not exposed with XPDM interface. These attributes are only exported if TDXExportMode is set 

to ExportXPDM (see section 3.3.2.1.28). 

The example above defines the V_versionComment attribute for export of VPMReference types 
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3.3.2.4.9 ImportStep (DS Cloud only) 

Settings for the step Import used by the Enterprise IP Exchange service. 

<ImportStep> 

 <ImportCompanyName>My Company name</ImportCompanyName> 

… 

</ImportStep> 

ImportCompanyName: The company name for the STEP header. Default is "T-Systems International 

GmbH". 

ImportCompanyId: The company id for the STEP header. Default is "www.t-systems.com". 

ImportJobPollingSleepPeriod: Time to sleep in milliseconds for the Job result polling. Default is 

10000. 

ImportJobMaximumDuration: Time in minutes to wait for the job result. Default is 30. 

ImportJobMaximumDurationResultsInError: true to set the job result to success if it runs longer than 

the ImportJobMaximumDuration. Default is true. 

DisableRevisionOrderImport: true to not set the revision order property for PartVersion and 

DocumentVersion. Default is false.  

EnableNon3DPartGeometryImport: True to enable the import of non 3DPart geometries, e.g. cgr, 

V4 model. 

3.3.2.4.10 ExportStep (DS Cloud only) 

Settings for the step export used by the Enterprise IP Exchange service. 

<ExportStep> 

 <ExportJobPollingSleepPeriod>10000</ExportJobPollingSleepPeriod> 

 <ExportJobMaximumDuration>60</ExportJobMaximumDuration> 

</ExportStep> 

ExportJobPollingSleepPeriod: Time to sleep in milliseconds for the Job result polling. Default is 

10000 (10 seconds). 

ExportJobMaximumDuration: Time in minutes to wait for the job result. 0 or negative for infinite. 

Default is 60. 

3.3.2.4.11 Configuration transfer to 3DEXPERIENCE 

This section defines settings for the configuration data import to 3DEXPERIENCE, for example the 

default revision when creating a new Model in 3DEXPERIENCE. 

All settings are optional and have default values. 

<DefaultModelVersionRevision>START</DefaultModelVersionRevision> 

The revision string for creating Model Version in Configuration import to 3DEXPERIENCE. The 

default revision is START. 

<EnableDeallocateVariant>false</EnableDeallocateVariant> 

Set to true to enable the deallocation of not existing Variants in 3DEXPERIENCE. Disabled by 

default. 

<EnableDeallocateVariantValue>false</EnableDeallocateVariantValue> 
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Set to true to enable the deallocation of not existing Variant values in 3DEXPERIENCE. Disabled by 

default. 

<ModelConfigurationSeparator>-</ModelConfigurationSeparator> 

The separator between Model name and Product Configuration when importing Product 

Configuration into 3DEXPERIENCE. The default separator is -. 

<ModelVariantSeparator>-</ModelVariantSeparator> 

The separator between Model name and Variant name when importing Variants into 

3DEXPERIENCE. The default separator is -. 

<VariantValueSeparator>-</VariantValueSeparator> 

The separator between Variant name and Variant value when importing Variants into 

3DEXPERIENCE. The default separator is -. 

3.3.2.4.12 HTTPClient 

<HTTPClient> 
    <ConnectionRequestTimeout>15000</ConnectionRequestTimeout> 
    <ConnectTimeout>15000</ConnectTimeout > 
    <SocketTimeout>50000</SocketTimeout> 
</HTTPClient> 

Define HTTP connection settings when connecting to 3DEXPERIENCE: 

• ConnectionRequestTimeout: timeout in milliseconds when requesting a connection from 

connection pool. Default: 15000. Set to 0 for no timeout and to negative to use system 

default. 

• ConnectTimeout: timeout in milliseconds until connection is established. Default: 15000. 

Set to 0 for no timeout and to negative to use system default. 

• SocketTimeout: timeout in milliseconds between two consecutive data packages. Default: 

50000. Set to 0 for no timeout and to negative to use system default. 

 

3.3.2.5 Features 

Enable or disable features if not required by use case. For example, in case of unidirectional transfer 

from 3DEXPERIENCE to Teamcenter only, you could disable Teamcenter to 3DEXPERIENCE 

functionality. 

<Features> 

 <SendTo3DX enabled="true"/> 

 <SendToPDM enabled="true"/> 

 <FolderSendTo3DX enabled="true"/> 

 <BookmarkSendToPDM enabled="true"/> 

 <ListTo3DX enabled="true"/> 

 <ListToPDM enabled="true"/> 

 <StructureCompare enabled="true"/> 

 <ReviseIn3DX enabled="false"/> 

 <MetaUpdateIn3DX enabled="false"/> 

 <Query3DXPhysicalProduct enabled="true"/> 

 <Query3DXBookmark enabled="true"/> 

 <Query3DXConfiguration enabled="false"/> 
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 <ConfigurationExportFrom3DX enabled="false"/> 

 <QueryPDMPartRevision enabled="true"/> 

 <QueryPDMPart enabled="true"/> 

 <QueryPDMFolder enabled="true"/> 

 <QueryPDMConfiguration enabled="false"/> 

 <ConfigurationExportFromPDM enabled="false"/> 

 <DetailsServlet enabled="false"/> 

 <FileCacheInfoServlet enabled="true" maxReturn="50"/> 

 <JobServlet enabled="true"/> 

 <TableInfoServlet enabled="true"/> 

</Features> 

Enable or disable by setting the enabled attribute: 

• SendTo3DX: transferring ItemRevisions to 3DEXPERIENCE. Default is enabled. 

• SendToPDM: transferring Physical Product to Teamcenter. Default is enabled. 

• FolderSendTo3DX: transfer Folders to 3DEXPERIENCE. Default is enabled. 

• BookmarkSendToPDM: transfer Bookmarks to Teamcenter (or legacy Engineering Folder if 

configured). Default is enabled. 

• ListTo3DX: transfer lists of ItemRevisions to 3DEXPERIENCE. Default is enabled. 

• ListToPDM: transfer lists of Physical Products to Teamcenter. Default is enabled. 

• StructureCompare: compare transferred objects between Teamcenter od 

3DEXPERIENCE. Default is enabled. 

• ReviseIn3DX: revise transferred objects in 3DEXPERIENCE without transferring structure. 

Default is disabled. 

• MetaUpdateIn3DX: synchronize attributes from Teamcenter to 3DEXPERIENCE without 

transferring structure. Default is disabled. 

• Query3DXPhysicalProduct: search for Physical Products in 3DEXPERIENCE. Default is 

enabled. 

• Query3DXBookmark: search for Bookmarks (or legacy Engineering Folders) in 

3DEXPERIENCE. Default is enabled. 

• Query3DXConfiguration: search for Models in 3DEXPERIENCE. Default is disabled. 

• ConfigurationExportFrom3DX: export of variant management dictionaries (Model, Model 

Version, Variants, Options) and effectivities. Default is disabled. 

• QueryPDMPartRevision: search for ItemRevisions in Teamcenter. Default is enabled. 

• QueryPDMPart: search for Items in Teamcenter. Default is enabled. 

• QueryPDMFolder: search for Folders in Teamcenter. Default is enabled. 

• QueryPDMConfiguration: search for Variant Rules in Teamcenter. Default is disabled. 

• ConfigurationExportFromPDM: export of Variant Conditions, Options and Variant Rules. 

Default is disabled. 
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• DetailsServlet: show Teamcenter or 3DEXPERIENCE object details based on object UID in 

Tools -> Details. Default is disabled. 

• FileCacheInfoServlet: show file cache entries in Tools ->File Cache. Use maxReturn to 

control how many results are shown. Default is disabled. 

• JobServlet: show information about submitted jobs in Tools -> Job. Default is disabled. 

• TableInfoServlet: query TCI Product and Document table in Tools -> Table Info. Default is 

disabled. 

3.3.2.6 XciWeb 

In the following chapters the configuration options for the tag XciWeb are described. 

3.3.2.6.1 AdminPassword 

<AdminPassword plaintext="true">XXX</AdminPassword> 

Admin password for “xci-admin” user. 

Default setting for plaintext is “false”. 

3.3.2.6.2 SessionTimeout 

<SessionTimeout>2000</SessionTimeout> 

The session timeout in seconds used for the TCI web interface. 

Default setting for SessionTimeout is “1800”. 

3.3.2.6.3 MaxQueryReturnNumber 

<MaxQueryReturnNumber>50</MaxQueryReturnNumber> 

The maximum number of objects returned for the 3DX and PDM queries. 

Default setting for MaxQueryReturnNumber is “25”. 

3.3.2.6.4 MaxDBReturnNumber 

<MaxDBReturnNumber>50</MaxDBReturnNumber> 

The maximum number of objects returned for the DB queries. 

Default setting for MaxDBReturnNumber is “25”. 

 

3.3.2.7 Scheduler 

The Scheduler functionality must be enabled with the enabled flag set to true. 

<Scheduler enabled="true"> 
… 
</Scheduler 

In the following chapters the configuration options for the tag Scheduler are described. 

3.3.2.7.1 ThreadPoolSize 

The ThreadPoolSize setting initializes the size of the Scheduler thread pool. The default is 5, 

minimum is 3. A restart is needed to use the new value. 

<Scheduler enabled="true"> 
 <ThreadPoolSize>5</ThreadPoolSize> 
… 
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3.3.2.7.2 StartupDelay 

The StartupDelay setting defines the stDartup delay for tasks without startTime setting in seconds. 

The default is 60 seconds. 

<Scheduler enabled="true"> 
 <StartupDelay>120</StartupDelay> 
… 

3.3.2.7.3 TaskList 

The TaskList contains a list of Task objects to be run with the scheduler. 

<Scheduler enabled="true"> 
 <startupDelay>20</startupDelay> 
 <TaskList> 
  <Task  name="PDM-Released" period="300" …>… 

The Task object is the definition of the Tasks to be scheduled. The Task contains a list of 

TaskSettings. The Task has the following attributes: 

• enabled – true to run the task. 

• name – the unique name of the Task. 

• loadClass – the class to use which implements the java interface TaskRunnable 

• startTime – the start time of the task, e.g. "14:12:00". 

• period – the period in seconds to wait for next start of the task. 

• type – the scheduler type FixedRate or FixedDelay 

o FixedRate: enabled first after the given initial delay, and subsequently with the given 

period. 

o FixedDelay: enabled first after the given initial delay, and subsequently with the given 

delay between the termination of one execution and the commencement of the next. 

The two standard implementations are com.tsystems.xci.scheduler.HandleReleasedPdmObjects 

and com.tsystems.xci.scheduler.HandleReleasedEnoviaObjects. 

3.3.2.7.3.0.1 HandleReleasedPdmObjects 

The HandleReleasedPdmObjects task queries for objects with a defined state in Teamcenter. If the 

found revision is a new version of a formerly transferred object a new Transfer Job is initiated for this 

revision. 

The following TaskSetting are supported. 

• initialStartTime – the initial start time if no further run of this task is known. 

• objectType – the Item Revision types to search for. 

• objectName – the object name to search for 

• itemId – the item id pattern. 

• statusList – list of status to search for. 

• projectId – list of project ID’s to search for. 

• revRuleName, revRuleUid, force, removeExistingNotProvided, and 

withGeometricalConversion, are the settings for the created Jobs. 
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o revRuleName – Revision Rule name, empty for default. 

o revRuleUid – Revision Rule UID, empty for default. 

o force – true to disable skip functionality 

o removeExistingNotProvided – true to remove existing children in 3DEXPERIENCE. 

o withGeometricalConversion – true to convert the imports to 3DEXPERIENCE. 

• waitForDesignJobs – true to wait for the Jobs to finish. 

• writeReport – true to write a report in the persistent directory 

The objectType, objectName, itemId, statusList, and projectId can contain multiple entries with the 

configured delimiting character in Teamcenter (Teamcenter default “;”). 

Example Task setting for HandleReleasedPdmObjects, start the task at 2:00 AM and repeat the task 

every 24 h. 

<Task  
 name="PDM-Released" 
 startTime="2:00:00" 
 period="86400"  
 loadClass="com.tsystems.xci.scheduler.HandleReleasedPdmObjects"  
 type="FixedRate"> 
 <TaskSetting name="initialStartTime">2020-11-09T00:00:00.000Z</TaskSetting> 
 <TaskSetting name="objectType">ItemRevision;Design Revision</TaskSetting> 
 <TaskSetting name="itemId"></TaskSetting> 
 <TaskSetting name="statusList">TCM Released;Frozen </TaskSetting> 
 <TaskSetting name="revRuleName">Any Status; No Working</TaskSetting> 
 <TaskSetting name="revRuleUid">QoU5$iOt5wQEgB</TaskSetting> 
 <TaskSetting name="force">false</TaskSetting> 
 <TaskSetting name="removeExistingNotProvided">true</TaskSetting> 
 <TaskSetting name="withGeometricalConversion">true</TaskSetting> 
 <TaskSetting name="waitForDesignJobs">false</TaskSetting> 
 <TaskSetting name="writeReport">true</TaskSetting> 
</Task> 
… 

3.3.2.7.3.0.2 HandleReleasedEnoviaObjects 

The HandleReleasedEnoviaObjects task queries for objects with a defined state in 

3DEXPERIENCE. If the found revision is a new version of a formerly transferred object a new 

Transfer Job is initiated for this revision. 

The following TaskSetting are supported. 

• initialStartTime – the initial start time, if not provided the time of the first run is used. 

• objectType – the revision types to search for (comma separated to search for multiple types). 

• objectName – the title (V_Name) search pattern. 

• plmExternalId – the part number (PLMExternalId) search pattern. 

• statusList – list of status to search for (comma separated to search for multiple types). 

• collaborativeSpace – list of collaborative spaces to search for (comma separated to search 

for multiple types). 

• force, and removeExistingNotProvided, are the settings for the created Jobs. 



<Scheduler> TCI configuration 

TCI Release 3.11 - Installation Manual 67 

o force – true to disable skip functionality 

o removeExistingNotProvided – true to remove existing children in Teamcenter. 

• waitForDesignJobs – true to wait for the Jobs to finish. 

• writeReport – true to write a report in the persistent directory 

Example Task setting for HandleReleasedEnoviaObjects, start the task at 2:00 AM and repeat the 

task every 24 h. 

<Task  
 name="TDX-Released" 
 startTime="2:00:00" 
 period="86400"  
 loadClass="com.tsystems.xci.scheduler.HandleReleasedEnoviaObjects"  
 type="FixedRate"> 
 <TaskSetting name="initialStartTime">2020-11-09T00:00:00.000Z</TaskSetting> 
 <TaskSetting name="objectType">VPMReference</TaskSetting> 
 <TaskSetting name="objectName"></TaskSetting> 
 <TaskSetting name="plmExternalId"></TaskSetting> 
 <TaskSetting name="statusList">FROZEN,RELEASED</TaskSetting> 
 <TaskSetting name="collaborativeSpace">Common Space</TaskSetting> 
 <TaskSetting name="force">false</TaskSetting> 
 <TaskSetting name="waitForDesignJobs">false</TaskSetting> 
 <TaskSetting name="writeReport">true</TaskSetting> 
</Task> 
… 
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3.3.3 3DEXPERIENCE Custom Configuration 

In the 3DEXPERIENCE batch server environment of the XPG Client Service Batch a  

pdm-cust-config.xml configuration file must be installed:   

<CATIA install path>\win_b64\reffiles\XPG\config\client\pdm-cust-

config.xml 

The following sample shows a sample configuration for the PDM custom configuration: 

<?xml version="1.0" encoding="UTF-8"?> 

<XPGCustConfig SchemaVersion="V6R2013x" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 

 xsi:noNamespaceSchemaLocation="..\..\XSD\XPG\pdm-cust-config.xsd"> 

  <ObjectsConfig > 

    <Object XPGXMLType="Product" V6Type="VPMReference" MappingType="DefaultCustomization" /> 

    <Object XPGXMLType="ProductInst" V6Type="VPMInstance" MappingType="DefaultCustomization" /> 

    <Object XPGXMLType="Rep3D" V6Type="3DShape" MappingType="DefaultCustomization" /> 

    <Object XPGXMLType="Rep3DAggr" V6Type="3DShape" MappingType="DefaultCustomization" /> 

    <Object XPGXMLType="Rep3DInst" V6Type="VPMRepInstance" MappingType="DefaultCustomization" /> 

    <Object XPGXMLType="Drawing" V6Type="Drawing" MappingType="DefaultCustomization" /> 

    <Object XPGXMLType="DrawingAggr" V6Type="Drawing" MappingType="DefaultCustomization" /> 

    <Object XPGXMLType="DrawingInst" V6Type="VPMRepInstance" MappingType="DefaultCustomization" /> 

  </ObjectsConfig> 

</XPGCustConfig> 

For more information about the 3DEXPERIENCE custom configuration please refer to the 

3DEXPERIENCE documentation. 
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4 Installing the TCI Teamcenter Rich Client Plugin 

4.1 Installation 

The TCI Teamcenter Rich Client Plugin extends the Teamcenter functionality to communicate with 

3DEXPERIENCE. 

You should perform the following steps with your Teamcenter administrator. 

Locate the downloaded archive file (TCI_TC_UI_[xxxx]_V[xxx].zip). Extract the content of the 

archive file to a temporary location, e.g. C:\temp\TCI_TC_UI_2312_V3.11.0.0. 

Inside the temporary installation location, locate the folder 

TCI_TC_UI_[xxxx]_V[xxx]\install\windows for an installation on a client with Windows 32-

bit or the folder TCI_TC_UI_[xxxx]_V[xxx]\install\windows_64 for an installation on a 

client with Windows 64-bit. 

Start the installation by double-clicking Setup.exe. 

The “TCI Teamcenter Rich Client Plugin” wizard appears. Click Next: 

 

Figure 2: Setup – Start page 

The License Agreement page displays the link to the general terms and conditions of software 

purchase and maintenance of T-Systems International GmbH. You have to click “I Agree” to get to 

the next page: 
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Figure 3: Setup – License Agreement page 

On this page you have to choose for which users you want to install the TCI Teamcenter Rich Client 

Plugin. Proceed with Next: 

 

Figure 4: Setup – Choose Users page 

On the Choose Install Location dialog you have to enter the folder where setup will install the TCI 

Teamcenter Rich Client Plugin. Select the path using the Browse button and proceed with Next: 
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Figure 5: Setup – Choose Install Location page 

On the next page you will be asked for the folder, where the Teamcenter Rich Client resides 

(TC_PORTAL_ROOT). The Rich Client folder is usually named “portal” and contains also the Rich 

Client start script “portal.bat”. 

Please contact your Teamcenter system administrator to make sure that the selected path is correct. 

Select the folder using the Browse button and proceed with Next: 

 

Figure 6: Setup – Choose Teamcenter Directory page 

Select the Teamcenter Rich Client start file. This is a batch script that is located in the Rich Client 

folder (the one you have selected in the previous step). The file is usually named “portal.bat”. 

Please contact your Teamcenter system administrator to make sure that you have selected the 

correct file. Select the file using the Browse button and proceed with Next: 
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Figure 7: Setup – Choose Rich Client start file page 

On the next page you have to define the TCI settings. Enter the correct value and proceed with Next: 

  

Figure.8: Setup – TCI settings page 

The Check Setup Information page lists all information which you have entered. If you detect some 

wrong information, please use the Back button to enter correct information, otherwise start the 

installation with click on the Next button: 
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Figure.9: Setup – Subsumption page 

For Teamcenter the registry will be generated. 

  

Figure 10: Setup – Installation Complete page 

Once the wizard has successfully completed, click Finish: 
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Figure 11: Setup – Finished page 

4.2 Silent Installation 

It is possible to use a silent installation for the client installation. 

4.2.1 Parameters 

The following parameters are available for the silent installation: 
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Parameter Name Example Value Description 

/S  Activates the silent mode. 

/User= value Admin Installation only for yourself 

(“User”) or for all users of the 

computer (“Admin”). Default is 

the highest possible value. 

/TeamcenterInstDir= (Directory path) C:\Program 

Files\Siemens\Teamc

enter2312\portal 

The directory of the Teamcenter 

Rich Client installation. 

<must be set> 

/TeamcenterPortalFile= (File full path) C:\Program 

Files\Siemens\Teamc

enter2312\portal\porta

l.bat 

The full path of the portal.bat 

start script file. 

<must be set> 

/TciServerURL= (URL) http://my.tci-

integration-

server.url:port/XCI 

The TCI Server URL. 

<must be set> 

/D=(Directory path) C:\TCI\TCI_TC_UI_23

12_V3.11.0.0 

The target directory of the 

installation. 

Table 7: Silent installation parameters for TCI Teamcenter Rich Client Plugin 

Teamcenter installation directory, portal.bat file and TCI server URL must be set. 

The parameter /S activates the silent mode. 

The parameter /User is optional. The highest possible value will be used as default value. 

The parameter /D is optional. A part of the value will be taken from the current directory. It must be 

the last parameter used in the command line and must not contain any quotes, even if the path 

contains spaces. Only absolute paths are supported. 

If one value is not given and it is not possible to fetch a value from the system the installation process 

will be stopped and the error message can be found in the file install.log. 

4.2.2 Usage 

For the silent installation please open a command line window as administrator. 

Inside the temporary installation location, locate the folder 

TCI_TC_UI_[xxxx]_[xxx]\install\windows for an installation on a client with Windows 32-

bit or the folder TCI_TC_UI_[xxxx]_[xxx]\install\windows_64 for an installation on a client 

with Windows 64-bit. 

Start the silent installation with a command line like this example: 

Setup.exe /S /User= Admin /TeamcenterInstDir= "C:\Program 

Files\Siemens\Teamcenter2312\portal" /TeamcenterPortalFile= "C:\Program 

Files\Siemens\Teamcenter2312\portal\portal.bat" /TciServerURL= "http://my.tci-

integration-server.url:port/XCI" /D=C:\TCI\TCI_TC_UI_2312_V3.11.0.0 
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The log file install.log of the installation will be stored in the current directory. There you can 

find the information about the installation process. 

When the installation ended successful you will find the success message in this file. 

4.3 Environment variables 

The installation creates the start script TCI_TC_UI_Start.bat. 

Here you can find an overview of the possible environment variables in this start script. 
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Environment Variable Example Value Description 

XCI_SERVER_URL http://my.tci-

integration-

server.url:port/XCI 

The TCI Server URL. 

<mandatory> 

XCI_TCIC_COMPATIBILITY False Use TcIC compatibility mode. 

See section 3.3.2.3.6 

XCI_SEND_OBJ_MGR_AS_STRING True true: use only event custom 

attributes and not the export 

document 

Default value is “true”. 

XCI_EXPORT_TYPE Text Document type for complex 

export data 

XCI_EXPORT_NAMED_REF Text The named reference type for 

complex export data 

XCI_ENABLE_OPEN_IN_3DX ON ON: Enable the command 

“Open in 3DEXPERIENCE Rich 

Client” in the Teamcenter Rich 

Client. 

Default is OFF 

XCI_CATDIRENV <pathtoenv>\CATEnv Required for 

XCI_ENABLE_OPEN_IN_3DX: 

the path to the 3DEXPERIENCE 

Environment directory. 

XCI_CATENV Env Required for 

XCI_ENABLE_OPEN_IN_3DX: 

the Environmentname for the 

3DEXPERIENCE Environment. 

XCI_CATSTART <dsinstallpath>\B423\

win_b64\code\bin\CA

TSTART.exe 

Required for 

XCI_ENABLE_OPEN_IN_3DX: 

Path to the cat start executable 

of the 3DEXPERIENCE client. 

XCI_ENABLE_OPEN_IN_DASHBOA

RD 

ON ON: Enable the command 

“Open in 3DEXPERIENCE 

Dashboard” in the Teamcenter 

Rich Client. 

Default is OFF 

XCI_3DX_DASHBOARD_URL http://3dexperience.url

:port/3ddashboard 

Mandatory for 

XCI_ENABLE_OPEN_IN_DASH

BOARD 

URL of the 3DEXPERIENCE 

Dashboard. 
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Environment Variable Example Value Description 

XCI_3DX_DASHBOARD_APP ENOSCEN_AP Optional for 

XCI_ENABLE_OPEN_IN_DASH

BOARD  

App in 3D Dashboard to show 

object 

Default is ENOSCEN_AP 

(Product Structure Explorer) 

XCI_3DX_TENANT OnPremise Optional for 

XCI_ENABLE_OPEN_IN_DASH

BOARD  

3DEXPERIENCE environment, 

must be set for cloud 

environment. 

Default is OnPremise 

Table 8: TCI Teamcenter Rich Client Plugin - environment variables 

 



 Installing the TCI Teamcenter Active Workspace Enhancement 

TCI Release 3.11 - Installation Manual 79 

5 Installing the TCI Teamcenter Active Workspace 

Enhancement 

5.1 Installation 

The TCI Teamcenter Active Workspace Enhancement extends the Teamcenter Active Workspace 

Client functionality to communicate with 3DEXPERIENCE. 

To install the Active Workspace Enhancement of TCI on the server the following steps have to be 

performed. 

Locate the downloaded archive (e.g. TCI_AWC_UI-3.11.0.0.01.zip). Unpack the archive to a 

directory, for example to “C:\temp\server\aws”. Inside this you will find several sub-directories, which 

contain the TCI enhancement for Active Workspace. 

Copy the directory tci-module to the src directory in the stage directory of your Teamcenter Active 

Workspace installation, e.g. “C:\TC2312\aws2\stage\src”. 

Merge the solution directory to the src\solution directory in the stage directory of your Teamcenter 

Active Workspace installation, e.g. “C:\TC2312\aws2\stage\src\solution”. 

Merge the image directory to the src\image directory in the stage directory of your Teamcenter Active 

Workspace installation, e.g. “C:\TC2312\aws2\stage\src\image”. 

Open a console window as administrator. 

Change to the stage directory of your Teamcenter Active Workspace installation, e.g. 

“C:\TC2312\aws2\stage”. 

Publish the new Active Workspace system including TCI with the command “awbuild.cmd” to the 

gateway. 

To connect Active Workspace with TCI server, set the Teamcenter Preference XCI_SERVER_URL 

matching the variable in Chapter 4.3, e.g. “http://my.tci-integration-server.url:port/XCI”. 
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6 Installing the TCI 3DEXPERIENCE Rich Client 

Extension 

6.1 Installation 

The TCI 3DEXPERIENCE Rich Client Extension extends the 3DEXPERIENCE functionality with TCI 

commands. 

You should perform the following steps with your 3DEXPERIENCE administrator. 

Locate the downloaded archive file (TCI_3DX_UI_R[xxxxx]_V[xxx].zip). Extract the content 

of the archive file to a temporary location, e.g. C:\temp\TCI_3DX_UI_R2024x_V3.11.0.0. 

Inside the temporary installation location, locate the folder 

TCI_3DX_UI_R[xxxxx]_V[xxx]\install\windows_64 for an installation on a client with 

Windows 64-bit. 

Start the installation by double-clicking Setup.exe and follow the instructions. The 

3DEXPERIENCE values will be received from the registry if possible. 

6.1.1 Installation in a 3DEXPERIENCE cloud environment 

If both a Cloud and On-Premise 3DEXPERIENCE Rich Client is detected on the machine, the user 

has to confirm with a checkbox if the installation is for Cloud or for On-Premise. Otherwise, the 

installer automatically detects the Cloud environment.  

An additional installer page is presented where these necessary values must be set.: 

▪ 3DSpace URL 

▪ Cloud Tenant 

For example, the 3DSpace URL and the Cloud tenant can be easily identified by starting the 

“Collaborations & Approvals” App from the 3D Compass menu: 
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Figure 12: 3DEXPERIENCE Cloud 3DSpace URL 

3DSpace URL: https://r1234567890123-eu1-space.3dexperience.3ds.com 

The 3DSpace URL also contains the name of the Cloud Tenant, but with lower-case “r”! 

Note: Change the starting letter “r” to upper-case letter “R” for the Cloud Tenant name! 

tenant=R1234567890123  

6.1.1.1 Adding the TCI 3DEXPERIENCE Rich Client Extension to the default client 

environment (optionally) 

The TCI 3DEXPERIENCE Rich Client Extension is a global add-in and should be available 

independently of the 3DEXPERIENCE Rich Client APPs that can be started from the 

3DEXPERIENCE web client.  

Replace the Env.txt, e.g.: 

"C:\Program Files\Dassault Systemes\B426_Cloud\CATEnv\Env.txt"  

with the TCI_3DX_UI_Env.txt from the installation, e.g.: 

"C:\Program Files\T-

Systems\TCI_3DX_UI_R2024x_V[X.YY.0.0]\config\TCI_3DX_UI_Env.txt" 

And add the following two lines at the end of the file: 

XCI_MODULE=TCI 
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XCI_SERVER_URL=http://my.tci-integration-server.url:port/XCI 

6.2 Silent Installation 

It is possible to use a silent installation for the installation of the rich client extension. 

6.2.1 Parameters 

The following parameters are available for the silent installation: 

Parameter Name Example Value Description 

/S  Activates the silent mode. 

/User= value Admin Installation only for yourself 

(“User”) or for all users of the 

computer (“Admin”). Default is 

the highest possible value. 

/3DXInstDir= (Directory path) C:\Program 

Files\Dassault 

Systemes\B426 

The directory of the 

3DEXPERIENCE installation. 

/3DXEnvFile= (File full path) C:\Program 

Files\Dassault 

Systemes\B426\CATE

nv\Env.txt 

The full path of the 

3DEXPERIENCE environment 

file. 

/XciServerURL= (URL) http://my.tci-

integration-

server.url:port/XCI 

The TCI Server URL. 

<must be set> 

/Tenant= (tenant name) R1234567890123 Cloud only: mandatory 

/3DSpaceURL= (3DSPACE URL) https://r12345678901

23-eu1-

space.3dexperience.3

ds.com:443/enovia 

Cloud only: mandatory 

/D=(Directory path) C:\TCI\TCI_3DX_UI_

R2024x_V3.11.0.0 

The target directory of the 

installation. 

Table 9: Silent installation parameters for 3EXPERIENCE Rich Client Extension 

TCI server URL must be set. 

The parameter /S is required. 

The parameter /User is optional. The highest possible value will be used as default value. 

Both values for the 3DEXPERIENCE installation are optional; the values can be fetched from the 

Windows registry. 

The parameter /D is optional. A part of the value will be taken from the current directory. It must be 

the last parameter used in the command line and must not contain any quotes, even if the path 

contains spaces. Only absolute paths are supported. 
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If one value is not given and it is not possible to fetch a value from the system the installation process 

will be stopped and the error message can be found in the file install.log. 

6.2.2 Usage 

For the silent installation please open a command line window as administrator. 

Inside the temporary installation location, locate the folder 

TCI_3DX_UI_R[xxxxx]_V[xxx]\install\windows_64 for an installation on a client with 

Windows 64-bit. 

Start the silent installation with a command line like this example: 

Setup.exe /S /User= Admin /3DXInstDir= "C:\Program Files\Dassault Systemes\B426" 

/3DXEnvFile= "C:\Program Files\Dassault Systemes\B426\CATEnv\Env.txt" 

/XciServerURL= "http://my.tci-integration-server.url:port/XCI" 

/D=C:\TCI\TCI_3DX_UI_R2024x_V3.11.0.0 

Start the silent installation for the cloud installation with a command line like this example: 

Setup.exe /S /User= Admin /3DXInstDir= "C:\Program Files\Dassault 

Systemes\B426_Cloud" /3DXEnvFile= "C:\Program Files\Dassault 

Systemes\B426_Cloud\CATEnv\Env.txt" /XciServerURL= "http://my.tci-integration-

server.url:port/XCI" /Tenant= "R1234567890123" /3DSpaceURL= 
"https://r1234567890123-eu1-space.3dexperience.3ds.com:443/enovia" 

/D=C:\TCI\TCI_3DX_UI_R2024x_V3.11.0.0 

The log file install.log of the installation will be stored in the current directory. There you can 

find the information about the installation process. 

When the installation ended successful you will find the success message in this file. 

6.3 Environment variables 

The installation creates the start script TCI_3DX_UI_Start.bat. 

Here you can find an overview of the possible environment variables in this start script. 
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Parameter Name Example 

Value 

Description 

XCI_DEBUG ON Enable the TCI debug 

XCI_ENABLE_OPENINPDMCMD ON Enable the Command to open the selected 

Product in the Teamcenter Rich Client or 

Web Client 

XCI_TEAMCENTER_PORTAL See sample 

below. 

Optional: Path to Teamcenter Rich Client 

portal.bat, if more than one client is 

installed. By default, will connect to the 

Teamcenter client that is associated with 

the *.ugs file extension. 

XCI_WEBBROWSER See sample 

below. 

Optional: Path to the web browser 

executable to be used for the open URL 

command. 

XCI_TEAMCENTER_WEBCLIENT

_URL 

See sample 

below. 

The webclient URL used to open the 

referenced object in a Teamcenter 

Webclient. This will disable the open in 

Teamcenter Rich Client functionality. 

XCI_SERVER_URL See Client 

extensions 

configuration 

Path to the TCI integration server 

Table 10: TCI 3DEXPERIENCE Rich Client Extension environment variables  

Samples for Environment variables: 

XCI_TEAMCENTER_PORTAL: 

D:\Teamcenter2312\portal\portal.bat 

XCI_WEBBROWSER: 

C:\Program Files (x86)\Microsoft\Edge\Application\msedge.exe 

XCI_TEAMCENTER_WEBCLIENT_URL (Teamcenter 12 Webclient): 

open default: 

http://tcserver:12080/tc/webclient#argument= 

open in Teamcenter Navigator app: 

http://tcserver:12080/tc/webclient#appCode=Navigator&argument= 

open in Product Structure app 

http://tcserver:12080/tc/webclient#appCode=PSE&argument= 

XCI_TEAMCENTER_WEBCLIENT_URL (Active Workspace): 

open default: 

http://tcserver:3000/#/com.siemens.splm.clientfx.tcui.xrt.showObject?uid= 

open the content page: 

http://tcserver:3000/#/com.siemens.splm.clientfx.tcui.xrt.showObject?page=Content&uid= 

6.4 Client extensions configuration 

The client must be configured using the 3DEXPERIENCE options dialog. 
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The TCI configuration dialog under Options → General → Compatibility shows some version 

information of the integration and the server URL can be configured to connect to the TCI integration 

server. The client supports the encryption of the communication channel using SSL. To enable this 

feature, the client must be configured to connect a https URL. 

Example: 

http://my.tci-integration-server.url:port/XCI 

Instead of using the preference you can also set the following variable in the start script 

TCI_3DX_UI_Start.bat: 

XCI_SERVER_URL 

Ex.: set XCI_SERVER_URL=http://my.tci-integration-server.url:port/XCI 

This URL will be used if the preference is not set. 

 

To verify the connectivity to the configured server the Check Server button can be used. A message 

will be shown to indicate successful or unsucssful connections. 
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7 Installing the XCI 3DEXPERIENCE Batch 

The XCI 3DEXPERIENCE Batch must be installed on any host that you configure to export or import 

from 3DEXPERIENCE.  

As a prerequisite the 3DEXPERIENCE Rich Client needs to be installed.  

The XCI 3DEXPERIENCE Batch utility requires licman21 as its license manager. 

For detailed information about installation and configuration of the XCI 3DEXPERIENCE Batch also 

see after installation the Readme files in the doc directory of the installation. 

7.1 Installation 

You should perform the following steps with your 3DEXPERIENCE administrator. 

Locate the downloaded archive file (XCI_3DX_BATCH_R[xxxxx]_V[xxx].zip). Extract the 

content of the archive file to a temporary location, e.g. 

“C:\temp\XCI_3DX_BATCH_R2024x_V3.11.0.0”. 

Inside the temporary installation location, locate the folder  

“XCI_3DX_BATCH_R[xxxxx]_V[xxx]\install\windows_64” for the installation. 

Start the installation by double-clicking “Setup.exe” and follow the instructions. The 

3DEXPERIENCE values will be received from the registry if possible. 

In the installation directory the file Report.txt is stored. It describes where the customized 

3DEXPERIENCE environment for the batch can be found.  

Make sure that the %JAVA_HOME% in your 3DEXPERIENCE environment is set correctly and 

points to a valid Java runtime.  

You should add the following best practice settings to the environment: 

XPG_ACTIVATE_3DPART=1   activate the 3D Part support 

XPG_ACTIVATE_NONCADDOC=1   activate the Non-CAD document support 

XPG_ACTIVATE_MAPPED_REVISIONFAMILY=1 activate the mapped Revision Family support 

XPG_ACTIVATE_DECOUPLINGEXPORT=1 activate variant and evolution effectivity export 

ENABLE_DETAILED_REPORT=1    enable a detailed report 

CATForceNotCertifiedGraphics=1   ignore outdated graphic card driver warning 

7.2 Additional Configuration for Post Processing for XPDM 

Additional configuration steps are required if you import any files to 3DEXPERIENCE or export via 

XPDM. 

7.2.1 Copy required library from the 3DEXPERIENCE environment 

This is only needed if "Set Maturity of Rep Children", "Set Maturity of Rep" or "Add configured 

material" is configured. 
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Copy the file eMatrixServletRMI.jar to  

...\XCI_3DX_BATCH_R<XXXX>_V<XXX>\win_b64\fromServer\docs\java 

You can find this file on the 3DEXPERIENCE server host: <3DEXPERIENCE installation 

directory>\server\win_b64\docs\java 

In some cases the following files in 

...\XCI_3DX_BATCH_R<XXXX>_V<XXX>\win_b64\fromServer\code\bin may have to be 

replaced with updated files from your 3DX Server installation after installation of a 3DX Fix Pack 

(you can check the installation with CheckServerConnection.bat):   

mxUtil.dll, vgalaxy7k.dll 

You can find these files on the 3DEXPERIENCE server host: <3DEXPERIENCE installation 

directory>\studio\win_b64\code\bin) 

eMatrixMqlU.dll 

You can find this file on the 3DEXPERIENCE server host: <3DEXPERIENCE installation 

directory>\adk\win_b64\code\bin). 

7.2.2 Configuration of the TSI 3DEXPERIENCE xPDM Post Process 

behavior 

TSI 3DEXPERIENCE xPDM Post Process comes with the configuration file  

...\XCI_3DX_BATCH_R<XXXX>_V<XXX>\win_b64\reffiles\TCIXpgConfig.xml 

The TCI Server URL must be configured in TCIXpgConfig.xml file. The 

TCIXpgPostProcess_SERVERURL attribute must point to the TCI installation: 

<?xml version="1.0" encoding="UTF-8" standalone="yes"?> 

<TCIXpgConfig> 

<Attribute name="TCIXpgPostProcess_SERVERURL" 

     value="http://my.tci-integration-server.url:port/XCI"/> 

</TCIXpgConfig> 

 

The following connectivity information for the Enovia server must be provided is specific options are 

used (eg. TCIXpgPostProcess_REPAIRINSTANCE=ON): 

Server URL of 3DEXPERIENCE server (https://enovia-server.url:port/3dspace)  

TCIXpgPostProcess_ENOVIASERVERURL=<3DEXPERIENCE Server URL> 

o It is mandatory to include the port in the URL. :443 for https and :80 for http if you did 

not choose a different port. 

3DEXPERIENCE username 

This 3DEXPERIENCE user has to be ENOVIA business and system administrator. You should use 

the same 3DEXPERIENCE user that is used for the XPDM import. 

TCIXpgPostProcess_ENOVIAUSER=<3DEXPERIENCE username> 

Encrypted 3DEXPERIENCE password 

TCIXpgPostProcess_ENCRYPTEDENOVIAPASSWORD=<encrypted password> 
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3DEXPERIENCE Vault (optional) 

TCIXpgPostProcess_ENOVIAVAULT=<3DEXPERIENCE Vault> 

If 3DPassport is used to check the 3DEXPERIENCE credentials: 

TCIXpgPostProcess_USE3DPASSPORT=ON 

7.2.3 Encrypting the password for the TSI 3DEXPERIENCE xPDM Post 

Process 

This step is only required if "Repair Instance" or "Set Maturity of Rep Children" is configured 

in the TSI 3DEXPERIENCE xPDM Post Process. 

The TSI 3DEXPERIENCE xPDM Post Process needs a direct (MQL) login to the 3DEXPERIENCE 

server. To use the post-processing it is necessary to store the login information in the environment. 

As it is not allowed to store a plain password, TSI 3DEXPERIENCE xPDM Post Process uses an 

encrypted password. 

Use the script "EncryptPassword.bat" to encrypt the 3DEXPERIENCE password. If you use the 

3DEXPERIENCE environment file <Your Path>\XCI_3DX_BATCH_<3DX-version>_<XCI-

version>\config\XCI_3DX_BATCH_Env.txt (created during the installation of this batch utility 

collection) you can just double click the batch file. If you use a different environment file you drag 

and drop your environment file on the script "EncryptPassword.bat", or use a command window:  

C:\<Your Path>\XCI_3DX_BATCH_<3DX-version>_<XCI-

version>\config\EncryptPassword.bat <path>\<your env-file.txt> 

You have to encrypt the password using the same Windows OS user that runs the XPDM 

import/export (XPGClientBatch service, or TSI3DXBatch). The encrypted password can be used on 

different hosts, as long as the import uses the same Windows user. 

You will be asked for the password to encrypt: 

Encrypt 3DEXPERIENCE password 

type password: 

After typing in your password the encryption is executed: 

starting encryption ... 

 Encrypting password: *************************************************** 

Encrypted  password: <26e5d4eencrpted331846533ppassworddcbe21975ssample> 

Insert encrypted password in TCIXpgConfig.xml 

 Press any key to continue . . . 

Insert the password in the configuration file TCIXpgConfig.xml. 

7.2.4 Test the TSI 3DEXPERIENCE xPDM Post Process environment 

This step is only required if "Repair Instance" or "Set Maturity of Rep Children" is configured 

in the TSI 3DEXPERIENCE xPDM Post Process! 

Use the script "CheckServerConnection.bat" to test your installation. 
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If you use the 3DEXPERIENCE environment file <Your Path>\TCI_3DX_XPP_<3DX-

version>_<XCI-version>\config\XCI_3DX_BATCH_Env.txt (created during the 

installation of this batch utility collection) you can just double click the batch file. If you use a different 

environment file you drag and drop your environment file on the script "EncryptPassword.bat", 

or use a command window:  

C:\<Your Path>\XCI_3DX_BATCH_<3DX-version>_<XCI-

version>\config\EncryptPassword.bat <path>\<your env-file.txt> 

You will get a warning if a needed library could not be loaded, or if one of the following settings is 

missing in the TCIXpgConfig.xml 

▪ TCIXpgPostProcess_ENOVIASERVERURL 

▪ TCIXpgPostProcess_ENOVIAUSER 

▪ TCIXpgPostProcess_ENCRYPTEDENOVIAPASSWORD 

If you get the message  "login: Cannot get instance of matrix/db/Context", please check the following 

settings: 

▪ wrong setting TCIXpgPostProcess_ENOVIASERVERURL 

▪ wrong TCIXpgPostProcess_ENOVIAUSER /   

TCIXpgPostProcess_ENCRYPTEDENOVIAPASSWORD combination 

▪ wrong / missing certificate (in case of https) 

▪ wrong setting TCIXpgPostProcess_USE3DPASSPORT 

This command also warns if the 3DEXPERIENCE user does not have the 3DEXPERIENCE 

privileges "system administrator" and "business administrator". These 3DEXPERIENCE privileges 

are required to repair an instance and to set the maturity of an imported object to a specified state:  

TCIMQL Library build:   Mar 31 2016 16:18:16 

3DEXPERIENCE server version:  3DEXPERIENCE R2015x HotFix 5 

!!! User MigratUsr does not have required ENOVIA business privileges !!! 

!!! User MigratUsr does not have required ENOVIA system privileges !!! 
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8 Installing the license manager 

8.1 Remarks 

The TCI requires Licman21 as its license manager.  

During the installation of the Licman, you have to specify a temporary working directory. Choose a 

directory where the user has full access rights. 

8.2 Running Licman as a regular executable on Windows 

If you install Licman with the setup program on Windows, it will be run as a service and require 

administrator rights. Beginning with ptf19, it is possible to launch Licman as a regular executable 

when the TCI is started. 

You need to set the license path variable: 

SET LICMAN_LICENSE_PATH=<port>@<host> 

Then call licman21_lld.exe as a regular executable. 

No execution of the setup routine is required in this case. 

For more information, see Licman User Manual. 
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9 Installing the COMReconV5 package 

If V5ToV6Preprocessing or V6ToV5Postprocessing is enabled, the COMReconV5 package must be 

installed. 

9.1 Installation 

The COMReconV5 package is delivered as a zip file (e.g. COMReconV5_R34.zip). 

9.1.1 Unzip the COMReconV5 package 

Unzip the package to disk (e.g. C:\TCI\COMReconV5_R34 see Figure 13: COMReconV5 package 

content) at the TCI install host (where the TCI web application is installed). 

 

Figure 13: COMReconV5 package content 

9.1.2 Create CATIA V5 environment file 

Copy the CATIA V5 environment file to the config folder. Open the copied Environment file and 

enhance the PATH variable with the win_b64 folder as shown in the following example. 

PATH=C:\TCI\COMReconV5_R34\win_b64;C:\Program Files\Dassault 

Systemes\B34\win_b64\code\bin;… 

9.1.3 Configuration 

Then open the go\COMReconV5.bat file for edit and customize the 4 environment variables to your 

environment and save the file. 

rem --------------------------------------------------------------------------- 

rem Please customize following variables for your environment. 

rem 

rem Installation directory of COMReconV5. 

rem Example: C:\TCI\COMReconV5_R34 

set COMRECONV5_INSTALL_DIR=C:\TCI\COMReconV5_R34 

rem  

rem Installation directory of CATIA. 

rem Example: C:\Program Files\Dassault Systemes\B34 

set CATIA_BASEDIR=C:\Program Files\Dassault Systemes\B34 

rem 

rem Directory where to find CATIA env-files. 

rem Example: C:\TSI\CATEnv 

set CONVERTER_ENVDIR=C:\TCI\COMReconV5_R34\config 

rem 
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rem Filename (without extension) that will be used by CATIA batch client. 

rem Example: COMReconV5_R34 

set CONVERTER_ENVFILE=COMReconV5_R34 

… 

9.1.3.1 Option File in 3DEXPERIENCE Cloud import scenario 

Settings for COMReconV5 are configured in two option files in the go subdirectory in the 

COMReconV5 installation. If data is imported into 3DEXPERIENCE Cloud, an additional option must 

be set tin the XCI_V5_V6.opt file for V5ToV6Preprocessing: 

# import stepx file – cloud 

# set the Name (title as partnumber in the V5 file 

# the Importer uses the partnumber for the Title 

-MetaDataAddtlPropsProduct=(Name::<Part Number>) 

9.1.4 Install Microsoft Visual C++ Redistributable Packages 

Login as user with administrative rights and install all the Microsoft Visual C++ Redistributable 

Packages from the vcredist folder. 

 


